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Release Notes Summary

The following is a summary of new features, improvements, and issues fixed for Version 4.9.0.

New Features

• Added ability to connect to Wordfast Server for remote terminology

• Added Hunspell Dictionary for Thai

• Added Hunspell Dictionary for Turkish

Improvements

• Moved More Options TM Lookup to the immediate left of Find Source

• Added Chain Files shortcut key to Shortcut Preferences

• Changed Transcheck Warning pop-up message to be clearer when reporting an issue

• Added the option to ignore alphanumeric codes during the Copy Source Check in Transcheck
Preferences

• Added shortcut key in Shortcut Preferences to navigate between open files (unbound)

• Changed label from “Keys” to “Shortcuts" throughout

• Moved Project Cleanup icon to the right on Project Files tab

• Updated Segment Changes report

Fixed Issues

• Issue causing slowness in the editor when Show Whitespace is enabled

• Issue where Cleanup could be performed without a Cleanup password

• Issue where Replace All did not change the status of a segment to Modified

• Issue where Transcheck Report sometimes opens with a 500 error

• Issue where certain DOCX Word files could not be converted to TXLF files

• Issue causing TM Lookup and Term Lookup panes to disappear when large Microsoft Windows
text scaling is set

• Issue causing update reminder to fail

• Issue that made application unresponsive when clicking in Google Translate links

• Issue causing application to not find its license file

• Issue where last word in a segment is showing up as misspelled even though it was corrected

• Issue where Spellcheck jumps to the beginning of the document before pop-up response

• Issue causing Auto-Propagation to work incorrectly for merged segments

• Issue causing Transcheck to fail on chained files

• Issue causing the application to freeze when filtering chained file segments
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• Issue causing the last modified segment action to fail on chained files

• Issue where term description was not included in a glossary exported as TBX

• Issue causing GLTM connection to disconnect after opening several segments quickly

• Issue where an attribute was added by Cleanup when Add Attribute was unchecked

• Issue preventing a user from pasting text in other dialogs when focus was on a locked segment

• Issue of not requiring user name and password when connecting to remote glossaries

• Issues of various user interface glitches

• Issue of unclear cause indication and explanation for White space in Transcheck
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Tickets 1
The following table lists the new features, improvements, and issues by ticket.

Ticket Summary Issue Type Priority Resolution

TRA-19859 Letter is doubled if SWSC is turned on Bug Major Fixed by
another
ticket

TRA-19799 TM Lookup: source concordance search fails if tu
user contains backslash

Bug Major Fixed

TRA-19728 Shortcut list isn't rendered on scroll after
preferences settings are restored on factory

Bug Trivial Fixed

TRA-19660 CLONE - There is white space under records in
Segment History grid

Bug Minor Fixed

TRA-19611 TSR | Preferences dialog is opened after 20
seconds if segment is cleared

Bug Critical Fixed

TRA-19610 Shortcuts | There is no description if shortcut is
already selected

Bug Minor Fixed

TRA-19594 WF4.8.2 unable to find license file (license file
being searched in different folder than it's stored)

Bug Critical Fixed by
another
ticket

TRA-19586 Different Transcheck Warning in desktop and
Online Apps

Bug Minor Fixed

TRA-19553 There is white space under TUs in TM Lookup
(screenshot)

Bug Minor Fixed

TRA-19551 TSO/TSR | Can't perform transcheck/segment
changes on chained files

Bug Major Fixed

TRA-19545 Server: Include WFPO feedback dialog on other
apps

Improvement Minor Implemented

TRA-19544 UI: Include WFPO feedback dialog on other apps Improvement Minor Implemented
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Ticket Summary Issue Type Priority Resolution

TRA-19538 Segment status isn't changed after NBSP is added
using ALT code

Bug Minor Fixed

TRA-19533 Remote TM copied with HTTP URL fails with
connection unsuccessful

Bug Minor Fixed

TRA-19525 Clicking in Google and Microsoft Translator links in
Preferences make the app unresponsive

Bug Critical Fixed

TRA-19498 Button for Application Close should not close
application if dialog is visible

Bug Major Fixed

TRA-19474 Spell Check | last word in a segment is still offered
as misspelled although is "changed"

Bug Major Fixed

TRA-19472 No segment can be opened after G and S is added
on scrolled file

Bug Major Fixed

TRA-19467 Change Keys to Shortcuts Improvement Minor Implemented

TRA-19436 MAC | Transcheck All, Get Bilingual Table and
Preview File are not working

Bug Critical Fixed

TRA-19431 Letter "W" is inserted into symbolic name when
user enters tmgr url by typing

Bug Minor Fixed

TRA-19428 UI: Add IDML Preview to TSO and TSR New Feature ImplementedImplemented

TRA-19425 Umlaut characters added at beginning of segment
adds two letters

Bug Minor Fixed

TRA-19419 TSO/TSR Transcheck Spellcheck > Dictionary
Management by Admin

New Feature Minor Implemented

TRA-19418 Transcheck Spellcheck > TXLF Editor Transcheck Task Minor Implemented

TRA-19417 Transcheck Spellcheck > Project Transcheck Task Minor Implemented

TRA-19416 Edge | User can type only one letter in a segment Bug Blocker Fixed
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Ticket Summary Issue Type Priority Resolution

TRA-19413 TM Lookup and Terminology panes aren't visible
for some display settings

Bug Major Fixed

TRA-19405 Content of WF is lost when user DnD txt file into
opened iframe

Bug Major Fixed

TRA-19393 OPE: Initiate communication with OPE New Feature Minor Implemented

TRA-19392 OPE: Create basic layout for editor New Feature Minor Implemented

TRA-19388 DnD file: Drop file dialog remains if user cancel
droping

Bug Minor Fixed by
another
ticket

TRA-19381 MAC | WF crashes on DnD Bug Major Fixed by
another
ticket

TRA-19379 Mask will blink when user holds file over Projects
list view

Bug Major Fixed

TRA-19373 Table Header | Sorting by TM Type is wrong
(reverse sorting)

Bug Minor Fixed

TRA-19372 Username and password input field are not
mandatory in Connect to remote terminology
dialog

Bug Major Fixed

TRA-19353 WFP desktop app gets selected during drag and
drop action

Bug Major Fixed

TRA-19333 Drag and Drop | Text from split actions can be
dragged and dropped in any input field

Bug Minor Fixed

TRA-19332 Table Header | Drag and Drop shouldn't be
enabled for Source/Target Language combo box

Bug Minor Fixed

TRA-19330 UI - Image of tag shows tag content for split
segments

Bug Minor Fixed
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Ticket Summary Issue Type Priority Resolution

TRA-19326 Paste Action Disabled In TM Lookup When Cursor
Is In Locked Segment

Bug Major Fixed

TRA-19310 TXLF Editor : Column header should display
source and target language label

Improvement Minor Implemented

TRA-19305 MAC - Cannot close Recovery dialog Bug Critical Fixed

TRA-19301 Segments get wrongly autopropagated after using
Merge or split option more than twice for same
segment

Bug Critical Fixed

TRA-19285 Docx file fails to create XLIFF document Bug Major Fixed by
another
ticket

TRA-19278 Result of previous segment is visible when user
opens segment after killing session in GLTM

Bug Major Fixed

TRA-19265 Add option for using UI dev resources in the build
application

Task Minor Implemented

TRA-19250 Chain files: Automatically open last modify
segment option in preferences causing no file can
be opened

Bug Critical Fixed

TRA-19242 Add shortcut in shortcut list for Chain Files action Improvement Trivial Implemented

TRA-19236 ID numbers disappear after Split action in Editor Bub Major Fixed

TRA-19229 Timestamp does not displays under last saved
column in the current project view

Bug Minor Fixed

TRA-19223 No Tm Dialog doesn't have focus Bug Trivial Fixed by
another
ticket

TRA-19221 MAC | App size isn't retained after closing app Bug Minor Fixed

TRA-19220 UI Localization update for 4.8 Task Minor Fixed
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Ticket Summary Issue Type Priority Resolution

TRA-19218 Grid filter: Wrong option name in order by menu Bug Minor Fixed

TRA-19216 JSP file isn't segmented as it expected Bug Critical Fixed

TRA-19212 UI: Support for WFServer Glossary across the
whole application

Task Minor Implemented

TRA-19209 Support for WF Server glossary in Current Project
View

Task Minor Implemented

TRA-19207 Create action controllers for shortcuts Task Minor Implemented

TRA-19204 Files Chaining: Last modified segment action(Shift
+F5) doesn't work

Bug Major Fixed

TRA-19201 WF4 blocks - form too large if trying to preselect
100+ files

Bug Critical Fixed

TRA-19200 Right click doesn't open for file tab Bug Minor Fixed

TRA-19195 [TSO/TSR] - current project is not updated Bug Minor Fixed

TRA-19193 Files Chaining - Application is frozen after filtering
table with no results

Bug Critical Fixed

TRA-19190 Files Chaining - Blue color is changed after
opening segment

Bug Major Fixed

TRA-19188 Files Chaining - Chain Files action stays enabled
after closing chained files

Bug Minor Fixed

TRA-19185 Preferences: Selection of checkbox "Include
unbound Commands" isn't applied

Bug Minor Fixed

TRA-19172 Replace All doesn't change status of active
segment

Bug Critical Fixed

TRA-19165 [Desktop]Gltm is disconnected after quickly
opening 10 segments and leaving it for a while

Bug Fixed
by
another
ticket

Fixed by
another
ticket
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Ticket Summary Issue Type Priority Resolution

TRA-19160 Error in browser console appears during closing
project

Bug Minor Fixed by
another
ticket

TRA-19154 Grid filter: Missing collapse and expand folder
option

Bug Major Fixed

TRA-19152 MAC | bad Application name in App Menu Bug Minor Fixed

TRA-19151 User is able to edit active segment although txlf x-
mask is visible

Bug Minor Fixed

TRA-19145 Cursor is visible at the end and after that it will be
positioned at the desired position

Bug Minor Fixed

TRA-19138 Warm start | Application is staring slower Bug Minor Fixed

TRA-19136 TM connection is broken after opening segment
using CTRL + down

Bub Major Fixed by
another
ticket

TRA-19135 TSO/TSR | Terms aren't rendered on segment
opening

Bug Major Fixed

TRA-19121 CLONE - TU editor | Undo/Redo actions error Bug Major Fixed

TRA-19111 Server: Selected functionality should be applied for
Blacklists

Bug Major Fixed

TRA-19085 Current Project View: HTTP error 500 when
transcheck is ran with all project files selected

Bug Critical Fixed by
another
ticket

TRA-19078 Merging two grids due to similar behavior Task Minor Implemented

TRA-19060 Kitchen Sink - Action Bar Task Minor Implemented

TRA-19057 Kitchen Sink - Grid Filters Task Minor Implemented

TRA-19056 Kitchen Sink - Virtual Table Task Minor Implemented
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Ticket Summary Issue Type Priority Resolution

TRA-19045 WF: editor: table filter: add text with explanation Improvement Minor Implemented

TRA-19042 In project view, move Project Cleanup icon to the
right

Improvement Minor Fixed

TRA-19027 Segment opening is slower when Show White
Space is active

Bug Major Fixed

TRA-19006 Table Header - Sorting Menu values are not
matching the ones from the header

Bug Minor Fixed

TRA-18997 [jxbrowser] Linux/Mac version WF opens in a
smaller window

Bug Critical Fixed

TRA-18984 Move "More Options" in TM lookup to the left of
"Find Source"

New Feature Minor Implemented

TRA-18976 Linebreaks should be pasted as whitespaces Improvement Major Reimplemented

TRA-18906 Solling through the file is very slow when Show
White Space Action is on

Bug Critical Fixed

TRA-18902 Transcheck | Whitespace - wrong explanation and
cause

Bug Major Fixed by
another
ticket

TRA-18867 Transcheck: Need proper segment Warning popup Improvement Major Implemented

TRA-18862 Transcheck: Warning Explanation missing Bug Minor Fixed by
another
ticket

TRA-18761 Terms aren't rendered for active segment when
user turns off Terminology highlight all

Bug Major Fixed

TRA-18738 CLONE - Build WF with updated SOLR Task Major Fixed by
another
ticket

TRA-18709 Testing message dialog parameters Task Minor Implemented
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Ticket Summary Issue Type Priority Resolution

TRA-18663 Kickoff Application Action to have configurable
check period

Task Minor Implemented

TRA-18527 Add option to ignore alpha numerics in copy
source check

Improvement Critical Fixed by
another
ticket

TRA-18498 TSR: Ribbon Layout to have Simple and Advanced
option

Improvement Critical Implemented

TRA-18459 Investigate EMC log error: null pointer during
startup

Task Major Fixed by
another
ticket

TRA-18451 Show Whitespace character option slows down
segment opening, file scrolling etc.

Bug Minor Fixed

TRA-18414 App blocks after modifying remote TM [spec case] Bug Major Fixed

TRA-18377 New Tm/Terminology/Blacklist Admin opening
should close already opened one

Task Major Implemented

TRA-18330 Action from context menu is enabled although no
segment is opened

Bug Minor Fixed

TRA-18309 Remove source locale from
BlacklistConnectionDescriptor

Task Major Fixed by
another
ticket

TRA-17942 Update Segment Changes report for Review Steps Improvement Critical Implemented

TRA-17801 Spellcheck doesn't work on Eclipse (Windows 10 ) Bug Major Fixed

TRA-17405 When Japanese is the target language, an extra
space is being inserted after punctuation.

Bug Minor Fixed by
another
ticket

TRA-17362 Spellcheck does not make changes to the last
word of each segment

Bug Critical Fixed by
another
ticket
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Ticket Summary Issue Type Priority Resolution

TRA-17334 Spellcheck jumps to beginning of document before
answering pop up

Bug Critical Fixed

TRA-17203 Seginfo attribute for leveraged segment from TM
with TU user

Improvement Major Fixed

TRA-17097 Segment Change Report | Wrong user listed for
pre-populated segment

Bug Minor Fixed

TRA-17058 Quick Tools: Attribute Added To TM When "Add
Attribute" Unchecked

Bug Major Fixed

TRA-17024 Decoupling Tm lookup and Term lookup display
timing

Improvement Minor Implemented

TRA-16865 Empty file is added during project creation Bug Major Fixed by
another
ticket

TRA-16554 WFP4: Add WFServer Glossary connection tab to
Remote Glossary

New Feature Critical Implemented

TRA-16312 Simple Project Creator | change tabular order Improvement Trivial Implemented

TRA-16264 Description Not Included in Glossary Exported As
TBX

Bug Major Fixed by
another
ticket

TRA-15850 Cleaned TUs with gltm(gltm has clean up
password) cannot be seen from editor

Bug Critical Fixed

TRA-15754 Add shortcut to navigate between all opened files Improvement Minor Implemented

TRA-14305 Change example in connect to remote Glossary/
TM dialogs

Improvement Trivial Implemented

TRA-7818 WEB: Cannot export Analysis report Bug Critical Fixed
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About Wordfast Pro 2
Wordfast Pro is a translation and editing application designed to improve the way in which translators
work. It presents translators with a collaborative environment where Translation Memory (TM) files can
be accessed quickly and efficiently. Wordfast Pro is a flexible application that can work with desktop TM
files or interact directly with a powerful TM server application. It can also operate as a stand-alone tool to
supplement existing translation workflows.

Reference: TXLF Editor Unlabeled Icons
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Getting Started 3
This chapter provides the basic information to get started in Wordfast Professional (Wordfast Pro).

Wordfast Pro is installed and accessed on a local computer (refer to Installing and Activating Wordfast
Pro).

Requirements

Wordfast Pro requires the following:

• Java JRE installed; if Java JRE is not present, it is installed automatically during Wordfast Pro
installation

• Activation of the full Wordfast Pro installation requires a license and registration

• Minimum RAM of 2GB

• Minimum resolution of 1366 x 768 is recommended

• Operating systems: Microsoft Windows 7 and 8, OSX 10.9+

Installing and Activating Wordfast Pro

Wordfast Pro is installed on a local computer as described here.

To install and activate Wordfast Pro:

 1. Download the Wordfast Pro installer from the website http://www.wordfast.com/ to a local hard drive.
 2. Run the installer.

Wordfast Pro opens in Demo Mode.

To activate Wordfast Pro, a license must be obtained and registered either online or offline.

  Note:

Wordfast Pro demo mode provides an opportunity to view and try out the functions with limitations.

With a non-licensed Wordfast Pro, you are limited to creating bilingual projects and storing up to 500
translation units in your Translation Memory.

 3. Purchase a Wordfast Pro license through the website http://www.wordfast.com/ and the Activation
Key is returned by email.

Refer to:

• Online Activation

• Offline Activation

http://www.wordfast.com/
http://www.wordfast.com/
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Online Activation

When you activate Wordfast Pro online you are emailed an Activation Key that you need to complete an
online activation.

To begin:

 1. Double-click the Wordfast Pro icon on your desktop.
 2. Click the Help tab.

 3. Click License Management.
 4. Click Online Registration.
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 5. Enter the returned activation key into the Activation Key field.
 6. Click OK.
 7. Restart Wordfast Pro.

Your Wordfast Pro installation is now activated.

  Note:

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Offline Activation

If you need to activate Wordfast Pro offline a License file is sent to you attached to an email after
providing your Activation Key. Save this license file to a known location on the computer where
Wordfast Pro is installed (preferably the Wordfast program folder).

To activate Wordfast Pro offline:

 1. Open Wordfast Pro.
 2. Click Help.
 3. Click License Management.
 4. Click Manual Registration.
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 5. Insert the returned activation key into the Activation Key field.
 6. Click Generate on the Manual Registration dialog box.

The text string "Copy the string below..." is returned in the text box below the instruction text.
 7. Copy this text string into an email and send it to the email address provided on the Manual

Registration dialog box below the Activation Key input field (shown above).
 8. Copy the license file that is returned in an email from Wordfast to the computer containing Wordfast

Pro.
 9. From within the Manual Registration dialog box, browse to the license file.
 10. Click OK.
 11. Restart Wordfast Pro.

The license is now active.

  Note:

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Managing Licenses

Below are the procedures for managing Wordfast Pro licenses:
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• Re-installing Licenses • Verifying Current License • Update Notification

  Note:

Upon opening Wordfast Pro, an update notification appears when there are newer versions available
(see Project Help).

Re-installing Licenses

You can reinstate your Wordfast license by re-activating Wordfast Pro as described below:

 1. Obtain a new activation code for Wordfast Pro through the website http://www.wordfast.com/.
 2. Follow the instructions for:

•    Online Activation •    Offline Activation

Verifying Current License

To verify the current Wordfast Pro license:

 1. Open Wordfast Pro.
 2. Select Help.
 3. Click License Management.

http://www.wordfast.com/
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The License Manager activation dialog box appears.

 4. Verify the license expiration date in the text below the Activation Key field.

The license status, as shown below, appears just below the Activation Key.

License will expire in 254 day(s)

Update Notification

Upon opening Wordfast Pro, an update notification appears when there are newer versions available.

Alternatively, check for updates as follows:

 1. Click Help.
 2. Click Wordfast 4 Update.
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A list of available updates appears (as shown).

Starting Wordfast Pro

After Wordfast Pro has been installed and activated on your computer it is ready to use.

To start Wordfast Pro:

 • Double-click the Wordfast Pro icon on your desktop.
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When Wordfast Pro opens, you are on the Projects tab. This view shows a list of all of your projects
and includes the Wordfast 4 drop-down menu of a number of basic functions.

Here is the Wordfast 4 drop-down in detail.

Reference: Projects Search and Sort.

Project Files Perspective

When a project is opened from  the Project List tab, Wordfast Pro automatically presents the Project
Files tab where your translation files are listed.
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The following shows the tools available on the Tools Ribbon of the Project Files tab and introduces
search and sort.

The Files and TXLF File Location columns can be ordered by typing the first letter or two of the item
to head the list then clicking the Sort Order arrow to the far right. These columns can be searched by
typing in a string of characters that are contained in the entry of interest. When a matching, unique string
is found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon.

Project Files Unlabeled Icons:

Icon Description Icon Description

Clear Filters resets the search filters Sort Order arrows, ascending and
descending

Order By sort options drop-down
menu

 
 

The sort options are available through the Order By drop-down menu.
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Project Help

You can obtain guidance on any application tool through the Help tab.

From this tab you can:

• Provide comments to Translations.com

• View a list of the latest Wordfast Pro updates

• Manage your Wordfast Pro license

• Display the version of Wordfast Pro that you have installed

• Access online help

TXLF Editor Perspective

When you open a file for translation or review, you are in the TXLF Editor. The TXLF Editor user
interface Translation tab with some options is presented below to familiarize you with the interface
layout.
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Function Tabs This bar lists all tabs that fit in your display and are used to access
the various tools of this application.

Tools Ribbon Icons for the available tools of the active tab (that fit in your display).
File Name Tab(s) This bar lists all open files or chained file. Each open file shows as a

separate tab across this bar.
Table Filters Use this row of fields to provide the filter criteria and other controls

for your searches in the open file.
Source Segment
Column

In this area is the collection of numbered source segments (color
coded) that resulted from sectioning the source file(s).

Editor Tabs In this work area a number of functions are available, including:

• TM Lookup

• Notes

• Segment History



Chapter 3 - Getting Started Wordfast

Copyright © Wordfast, LLC 2016.   Page 30 of 217

• Metadata

• Transcheck (x) where x is the count of errors in segment
Target Segment Column This is the translation work area that includes:

• Target column (right column) where the translation is entered
or leveraged

• Segment Score column contains the percentage of match
found in the TM

• Status column indicates the status of that segment
Terminology Use this work area for searching and adding terms to terminology

lists (glossaries), if enabled.
Additional Tools This Drop-down lists additional tools that do not fit in your display

area.

Translation Edit Drop-down Menu

This drop-down menu is the TXLF Editor Context Menu that you can access by right-clicking anywhere
in the Source or Target segments.

TXLF Editor Unlabeled Icons

Translation files are TXLF files and you can edit these files using the TXLF Editor tool. The unlabeled
icons used throughout TXLF Editor are shown in the following table.
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Icon Description Icon Description

Transcheck error. A non-linguistic
error has occurred in the segment.

A note has been added to the
segment.

The segment has been repeated.
The segment is locked and cannot be
edited.

The segment is marked unconfirmed
and cannot be committed to the TM.

Information is available.

Apply the selected table filter. Accumulate the selected table filters.

Reset the Terminology search Filter
criteria.

Clear the search filters.

Select the term search target for
Terminology and Table Filters.

Expand or collapse the options
ribbon.

Expand or collapse the lower panel.
Click to add a term to the
Terminology list.

The segment has been modified.    



Copyright © Wordfast, LLC 2016.   Page 32 of 217

Project Management 4
Project management includes creating projects, preparing files for translation, and managing the
translation process. Translation-related files and the rules for a given translation must be set up before
anyone can begin a translation.

Projects Search and Sort

The Projects, Location, Source Language, and Target Language columns can be ordered by typing
the first letter or two of the item to head the list then clicking the Sort Order arrows on the far right.
These columns can be searched by typing in a string of characters that are contained in the entry of
interest. When a matching, unique string is found in an entry, only that entry is presented in the list. To
restore the list, click the Clear Filters icon. (Reference Project Files Perspective.)

Projects Tasks

The tasks directly related to managing a project are:

• Creating Projects • Opening Projects • Removing Projects

Creating Projects

In Wordfast Pro, it is necessary to create a project before any file translation can take place. A TXLF
file can only be opened for translation after the project is created or opened. The project is a working
environment that identifies the settings for the source and target language, Translation Memory (TM),
glossary, and other user information. The following tools are provided for creating projects:

•    Simple Project Creation •    Advanced Project Creation
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Simple Project Creation

To create a project using the standard (simple) interface:

 1. Click the Create Project Drop-down Symbol (downward pointing triangle) as shown below and the
menu opens.

Reference: Projects Search and Sort
 2. Click Use the simple project creator from the Create Project drop-down menu.

The Simple Project Creation dialog box appears.

 3. Enter a project name in the Project Name field.
 4. Select the source language from the left Languages drop-down list.
 5. Select the target language from the right Languages drop-down list.
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 6. To browse to project files:

• Click Add Files

• Or, drag the file(s) from a folder into the Files list area

The selected files are listed in the Files list.

  Note:

A green check-mark in the Valid column indicates the file is acceptable. A red X in the Valid column
indicates that the file type is not supported by Wordfast Pro filters.

 7. Select Translation Memory for this project using one of the following options (radio buttons):

Radio Button Description

Add TM Connect to an existing local Translation Memory (TM)
database.

Use Existing Connect to an existing Translation Memory database from
another project.

Create New Build a new Translation Memory database.

Do not use TM for this project No Translation Memory is to be used for this project.

 8. Click Finish.
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Wordfast Pro analyzes the file(s), then presents the summary pop-up.

Advanced Project Creation

In Advanced Project Creation you have the additional options to add Translation Memory, Glossaries,
and Reference files,

To create a project using the advanced project creation tool:

 1. Click the Create Project Drop-down Symbol (downward pointing triangle) as shown below and the
menu opens.

 2. Select Use the advanced project wizard from the Create Project drop-down menu.

Reference: Projects Search and Sort
 3. Select an option for this project. The options are listed in the following table.
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Option Description

Create New Project Begin from nothing in creating this project.

Create Project based on the
previous Project

Begin with the profile of some previously created, local
project.

Create a Project based on a
Project from the list

Build a new project with initial content from a selected project
found in the project list.

Location Browse to a location where the new project is to be stored.

 4. Enter a project name in the Project Name field.
 5. Click Next.
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The Language Selection dialog box appears.

 6. Select the source and target languages:

a) To change the selected originating language, select a different language from the Source
Language drop-down list.

b) To change the selected translated language or add another language (multiple target languages
are supported), select a different language from the Target Language drop-down list.

c) Click Next.

The Add Source Files dialog box appears.
 7. Add files using one of the following methods:

• Drag the file(s) into the file list area.

• Click Add File and select the file(s).
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 8. Click Next.

The Translation Memory dialog box appears.
 9. In the Translation Memory dialog box, select:

a) Create a TM.

• Enter unique name for the new project

• Select the languages

• Provide location for the project files

• Select TM Priority
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• Select whether TM is to be Read-only

b) Add Local

• Select the TM folder.

• Click Next.

c) Add Remote.

• Select the TM Server or WF Server

• Refer to Connecting Remote TMs
 10. Click Next.

The Terminology dialog box appears.
 11. In the Terminology dialog box provide the required information.

a) Create: initiate a new, local Terminology database (Termbase).

b) Add Local: select an existing local Termbase to be selected through browsing.

c) Add Remote: select an existing Term Manager connection.

d) Modify: edit selected Terminology (local or remote).

e) Remove to delete a selected terminology.
 12. Click Next.

The References dialog box appears.
 13. Select a set of files using one of the following options:
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• Add File: select an existing reference file

• Add Folder: select an existing folder for reference files

• Remove: delete selected reference files from the list
 14. Click Finish.

The document files are analyzed. A Progress bar shows the progress as percent complete.

The Project Creation Summary appears upon completion.
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Opening Projects

Projects must be opened before any files can be opened for translation and related operations can take
place.

Submissions being assigned from Project Director are downloaded from Project Director by running a
Get Translation Files Offline. If you choose the GlobalLink© Package (GLP) format the GLP files are
then packed into a ZIP file. Take these GLP-ZIP files and import them into Wordfast. Refer to Using GLP
Files.

Reference: Projects Search and Sort

To open a project from the Wordfast Pro Projects tab:

 1. Select a project.
 2. Click Open Project or double-click the project.

The Project Files tab appears as shown.

References for details of the Wordfast Pro Project tabs:
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• Working with Projects

• Working With Terminology

• Project Reference Files

• Working with Project Translation Memory

• Reports

• Project Help

Using GLP Files

A GlobalLink Package (GLP) enables a project to be passed around in a coherent structure. The GLP
comprises everything required to send a project to a team member permitting that member to work on
the project. Using this option, projects can be transferred between Wordfast Pro installations without
requiring a manual setup on the importing Wordfast Pro installation. A GLP can contain both complete
and incomplete projects. GLPs can include:

• Project files: Bilingual SDL XLIFF files and reference files

• Local and remote project Translation Memory

• Local and remote main Translation Memory references

• Local and remote termbases references

• Auto-Suggest dictionaries

• Automated translation provider connection details

• The Analyze and Word Count reports (generated during package creation)

• Project settings

  Note:

GLP files do not include the project source files but they can be added as reference files when you
create a the package on the Export Package dialog box under the Resources To Include In Export

A completed package can be sent by email, posted on an FTP site, or some other method to make the
project files available to another person.

• Importing Packages • Exporting Packages

Removing Projects

To remove a project from the resident projects list:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select the project to remove.
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Reference: Projects Search and Sort
 3. Click Remove Project.

The Projects List reappears with the selected project no longer in the list.

  Note:

After a project is removed it can no longer be retrieved without adding it back into the project.
Removed projects are not erased and can be retrieved from the original folder using Add.
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Working with Projects 5
When Wordfast Pro is started, the Projects tab lists all resident projects from which one (and only one)
can be selected and opened. Refer to Opening and Translating Files.

Project Files Search and Sort

The Files and TXLF File Location columns can be ordered by typing the first letter or two of the item
to head the list then clicking the Sort Order arrows on the far right. These columns can be searched by
typing in a string of characters that are contained in the entry of interest. When a matching, unique string
is found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon.
(Reference Project Files Perspective.)

Project Files Tasks

With a project selected, the following tasks are available:

• Adding Files

• Cleanup

• Modifying Projects

• Analyzing Projects

• Running Export Notes Report

• Exporting Packages

• Adding Folders

• Closing Projects

• Cleaning Up Files

• Running Segment Changes Report

• Importing Packages

• Removing Files

References:

• Translating Files • Using Transcheck
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Adding Files

You can add files to an existing project using the Add Files tool on the Project Files tab.

To add files to a project:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Open the project.

 3. Click Add Files.

 4. In the file Open navigation dialog box, browse to the file and select it.
 5. Click Open.

The file is analyzed and a Files Report appears.

 6. Click OK.

The Report File dialog box closes and the added files are then listed.



Chapter 5 - Working with Projects Wordfast

Copyright © Wordfast, LLC 2016.   Page 46 of 217

Adding Folders

You can add a group of files to an existing project using the Add Folders tool on the Project Files tab.

To add files for translation from a folder to a project:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Open the project.

Reference: Project Files Search and Sort.
 3. Click Add Folders.

The Add Folder dialog box appears.

 4. Select:

• A folder

• Make New Folder
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 5. Click OK.

Modifying Projects

You can change a project's name, source language, and target language using the Modify Project tool.

To modify a project from the Projects tab:

 1. Go to the Projects list tab (refer to Opening Projects).

Reference: Project Files Search and Sort
 2. Select a project.
 3. Click Modify Project. 

The Modify Project dialog box appears.

 4. Change the project name as necessary.
 5. Modify the source language as necessary if this option is available.
 6. Make the target language changes as necessary by selecting from the drop-down list.
 7. Click OK.
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Closing Projects

When you are through working with a project, you can close it using the Close Project tool.

To close a project on the Project Files tab:

 • Click Close Project.

Reference: Project Files Search and Sort.

The project is closed and the Projects list tab is reopened (as shown).

Reference: Projects Search and Sort

Cleaning Up Projects

After files are translated, the translation project is ready for a clean up and an update to the Translation
Memory (TM) files. The project clean-up process requires a manual initiation. Following this clean-up an
automated process removes the source segments and restores the files to their original format.
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To clean up and update the Translation Memory from the Project Files tab:

 1. Click Project Clean Up.

The Project Clean Up dialog box appears.

 2. Select the languages to clean up:

• All Language Pairs

• Specific Language Pairs

• Single Language Pair



Chapter 5 - Working with Projects Wordfast

Copyright © Wordfast, LLC 2016.   Page 50 of 217

 3. Select where the translated files are to be placed:

• Place translated files in the project folder

• Place translated files in the original path of source files

• Enter the location to put translated files
 4. Select Create subfolders by language as appropriate.
 5. Select Add language suffix to the translated file name as appropriate.
 6. Select TM Overwrite Options.
 7. Select the TM(s) to Update.
 8. Click Clean Up.

Cleaning Up Files

The Project Manager is responsible for the cleaning up of translated files and selecting the TM update
options. To initiate this manual process refer to Cleanup.

Analyzing Projects

In Analyzing Projects, files for translation are analyzed against a Translation Memory to leverage
reusable content and initiate a pre-translation.

To analyze files from the Project Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select the project and click Open Project.

The Project Files tab appears listing the files for translation.
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 3. Click Analyze Project on the Project Files tab.

The Project Analyze dialog box appears.

 4. Select the file(s) to be analyzed.
 5. Select the appropriate Analysis Options as follows (refer to Configuring Translation Memory):

a) Select Pretranslate to create translated TXLF files, including the options:

• Match percentage criteria

• Copy all tags on segments when there is no TM match

• Copy segment source to target when there is no TM match
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• Do nothing

b) Select Report Settings:

• Show only analysis report summary

• Export Report

◦ Report Name

◦ Report Type

◦ Report Location

c) Translation Memory, select one or more TM to use during this analysis.
 6. Click Analyze.

A pop-up appears showing the report percentage progress.

The analysis completes and the Report File summary appears.

Running Segment Changes Report
 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
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3. Click Segment Changes Report.    

The Segment Changes Report dialog box appears.

 4. Make the required selections.
 5. Click Export.

The following example shows an exported Segment Changes report.



Chapter 5 - Working with Projects Wordfast

Copyright © Wordfast, LLC 2016.   Page 54 of 217



Chapter 5 - Working with Projects Wordfast

Copyright © Wordfast, LLC 2016.   Page 55 of 217

Running a Segment Changes Report also presents a Segment Changes Summary pop-up as
shown.

 6. Click OK.

Running Export Notes Report

You can determine how many notes are attached to a project's files and view them in a report by running
an Export Notes Report.

To export notes into an HTML file format:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.

You are presented with the Project Files tab.

 3. Click Export Notes under the Project Files tab.
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The Export Notes Report dialog box appears.

 4. Click Export.

The export summary appears.

 5. Click OK.

The Notes export HTML file is created in the folder you selected and is available for viewing.

Importing Packages

Using the Import Package option, a GLP project file can be imported from another Wordfast Pro
installation fully and not require any setup.
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To import project files:

 1. Click Import Package (or drag and drop a GLP file).

Reference: Projects Search and Sort.

The Import Package dialog box appears.
 2. Use Browse to locate and select the GLP file.

The Import Package dialog box is populated with the selected file name and a drop-down list of
available projects in the GLP.

 3. Select a GLP file.
 4. Click one of the following options:

• Update A Current Project for an existing project and provide the project name, then select:

◦ Only update existing project TXLF files
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◦ Update existing and add new files

• Create New Project for a new project and provide a project name and location, then provide:

◦ The new Project Name

◦ The new project Location
 5. Optional: Select Open Project After Import to open the updated or new project when the import

completes.
 6. Click Import.

If Open Project After Import was checked, the current project view opens in the Project Files tab
listing the TXLF files for translation.

Exporting Packages

A GlobalLink Package (GLP) of project files comprises everything required for a project. Using the
Export Package option, a complete project package can be shared with other Wordfast Pro installations
without requiring a manual setup of the project on the receiving Wordfast Pro.

To export a project package (GLP):

 1. On the Projects tab, select the project.

Reference: Project Files Search and Sort.
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 2. Click Export Package.

The Export Package dialog box appears.

 3. Select export type:

• Entire Project

• Specific target languages and resources selectively, including:

◦ Source Files

◦ TXLF Files

◦ Glossaries

◦ Translation Memories

◦ Reference Files
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◦ Blacklists
 4. Select a naming convention.

• GLP Name to have
the export process
name the file

• Custom Name to
specify the name to
be used

 5. Select a location to receive the GLP file.
 6. Click Export.

The exported GLP is built and saved to the selected folder. This GLP file can now be passed on to a
different Wordfast Pro installation.

Removing Files

Files can be removed from a project through the Project Files tab.

To remove a file or files:

 1. Go to the Projects list tab (refer to Opening Projects for more information).
 2. Select and open the project.
 3. Select the file to be removed.

Reference: Project Files Search and Sort.
 4. Click Remove File(s).

The file is removed from the current project.
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Working with Project Translation Memory 6
Working with Translation Memory (TM) provides maximum content re-use and facilitates collaboration
between globally distributed localization resources.

Translation Memory (TM) can be managed both by project managers and translators. Translation
Memory management is accessed from the Project TM tab.

Project TM Search and Sort

The Files column of the Project TM tab can be ordered by typing the first letter or two of the item to
head the list then clicking the Sort Order arrows on the far right. These columns can be searched by
typing in a string of characters that are contained in the entry of interest. When a matching, unique string
is found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon.
(Reference Project Files Perspective.)

Project TM Tasks

The Project TM tab includes the following tasks:

• Creating Local Translation Memory

• Connecting Remote TMs

• Modifying Local TMs

• Importing Translation Memory

• Removing Translation Memory

• Adding Local TMs

• Opening Local Translation Memory

• Copying Translation Memory

• Exporting Local Translation Memory

References:

• Configuring Translation Memory

• Customizing Colors
• Configuring Penalties



Chapter 6 - Working with Project Translation Memory Wordfast

Copyright © Wordfast, LLC 2016.   Page 62 of 217

Creating Local Translation Memory

A new local Translation Memory can be created for an existing project as described below.

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project TM tab, click Create Local.

Reference: Project TM Search and Sort.

The Translation Memory Create dialog box appears.

 4. Enter the Translation Memory information as described in the following table.
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Option Description

Name
Enter a TM name. A good practice is to enter a name that includes a client or
organization name and the TM's language.

Target Language The target language selection is limited to those declared in the project.

Location The location where the new TM is to be saved.

Priority
This relative priority determines the sequence of reference during translation
where the Primary TM is first to be referenced and only one TM can be
designated as primary.

Selected
Checking Selected indicates that this TM is to be used for the current
project.

Read Only Selecting this option prevents any write action to the TM.

 5. Click OK.

The new Translation Memory is created and reflected in the project Translation Memory list.

Adding Local TMs

Adding a local Translation Memory is for WFP-4 format (different from WFP-3) Translation Memory only.
To add local Translation Memory to an existing project from the Project TM tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
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Reference: Project TM Search and Sort
 4. Click Add Local.

The Browse For Folder dialog box appears.
 5. Select a Translation Memory.
 6. Click OK.

The selected local Translation Memory is added to the project and listed in the project Translation
Memory tab.

Connecting Remote TMs

While Wordfast Pro is a locally run program, it can access remote Translation Memory (TM). The types
of remote TMs that can be connected are: GLTM/WFTM and TM Server 4.

To connect to a remote TM:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
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Reference: Project TM Search and Sort
 4. Click Connect To Remote on the Project TM tab as shown.

The Connect to Remote TM dialog box appears).
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Adding Translation Memory Connections

To add a remote Translation Memory using a TM or WF server:

 1. Go to the Connect to Remote TM dialog box.

 2. To Add a TM Server:

a) Click the TM Server tab.

b) Enter a unique name in the Symbolic Name field.

c) Enter the remote Translation Memory URL (provided by PM) in the URL field following the
example template shown in that field.

  Note:

The URL settings are populated automatically as provided within the URL string.

d) Select a Priority from the drop-down.

e) Click Selected to enable this Translation Memory.

f) Click Read Only to prevent modifications.
 3. To Add a WF Server:
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a) Click the WF Server tab.

b) Enter a unique name in the Symbolic Name field.

c) Enter the remote Translation Memory URL (provided by PM) in the URL field following the
example template shown in that field.

  Note:

The URL settings are populated automatically as provided within the URL string.

d) Click Use TM Write Password if appropriate and supply the password.

e) Select a Priority from the drop-down.

f) Click Selected to enable this Translation Memory.

g) Click Read Only to prevent modifications.
 4. Click OK.

Opening Local Translation Memory

Current Translation Memory can be opened and edited if and only if it is local.
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To open the current projects Translation Memory from the Project TM tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select a Translation Memory file.

Reference: Project TM Search and Sort
 4. Click Open TM.
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The Translation Memory dialog box appears.

  Note:

Only local Translation Memory can be opened and edited through this function.

Modifying Local TMs

Local Translation Memory can be edited from the Project TM tab as follows:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
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Reference: Project TM Search and Sort
 4. Click Modify TM (shown above).

The modify Translation Memory dialog box appears.    

In this example the Read Only option was selected to protect the Primary TM.

 5. Click OK to save changes.

Copying Translation Memory

Local Translation Memory can be copied to a local file. The file copy is in the Wordfast Pro 4 format and
cannot be used with Wordfast Pro 3.
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To copy a Translation Memory:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
 4. Select a translation memory.

Reference: Project TM Search and Sort
 5. Click Copy TM.

The Copy TM dialog box appears.

  Note:

If Flip Languages is selected, the source TM and target TM languages are reversed.

 6. Enter a name for the copy and its destination folder.
 7. Click Copy.
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Importing Translation Memory

You can import Translation Memory into an existing project through the Project TM tab.

To import a translation memory profile:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.

Reference: Project TM Search and Sort
 4. Click Import TM.

The Import Translation Memory dialog box appears.

 5. Make selections.
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The file formats supported for import are:

• WF Classic TM: The format supported by Wordfast Classic and Wordfast Pro 3.

• TMX: The standard format supported by all translation tools.
 6. Use the Browse For Folder to identify a folder to receive the TM copy.
 7. Click Browse.

a) Select the TM file.

b) Click Open.
 8. Click OK.

The Create Translation Memory dialog box returns with all fields populated.
 9. Click OK.

The new TM is created in the specified folder.

Exporting Local Translation Memory

Local Translation Memor can be exported through the Project TM tab.

To export a local Translation Memory from the Project TM tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.

The Translation Memory tab appears.

Reference: Project TM Search and Sort
 4. Select the Translation Memory file to export.
 5. Click Export TM.



Chapter 6 - Working with Project Translation Memory Wordfast

Copyright © Wordfast, LLC 2016.   Page 74 of 217

The Export Translation Memory dialog box appears.

 6. Select a Translation Memory.

  Note:

The selected Translation Memory file and export type can be changed using their respective drop-
down lists.

 7. Select the export file type.
 8. Browse and select the save File path.
 9. Click OK.

A confirmation appears upon completion.

Removing Translation Memory

Translation Memory can be removed from a project without erasing the file through the Project TM tab.

To remove Translation Memory from the current project:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Click the Project TM tab.
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Reference: Project TM Search and Sort
 3. Select the TM to delete.
 4. Click Remove TM (as shown in the preceding example).

A TM removal confirmation pop-up appears.

 5. Click Yes to complete the removal.
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Working With Terminology 7
Project Terminology is used to manage the related glossary and blacklist terms. Projects utilize a
collection of terms used in previous translations to facilitate new translations. These terms consist of both
preferred (Glossary) and rejected (Blacklist) terms.

Project Terminology Search and Sort

The Glossary Name or Blacklist Name, and Location columns can be ordered by typing the first letter
or two of the item to head the list then clicking the Sort Order arrows on the far right. These columns
can be searched by typing in a string of characters that are contained in the entry of interest. When a
matching, unique string is found in an entry, only that entry is presented in the list. To restore the list,
click the Clear Filters icon. (Reference Project Files Perspective.)

Project Terminology Tasks

Below is a list of Terminology related activities and useful references:

• Working with
Glossaries

• Working With Blacklists • Modifying and Removing
Glossaries, Blacklists

References:

• Configuring Terminology • Customizing Colors

Working with Glossaries

A glossary is a list of source terms and their preferred translations. For example, a list could include
information as shown in the table below.
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Source Target

Translation Memory mémoire de traduction

Translation Unit unité de traduction

Data Transfer Rate taux de transfert de données

International Translators Federation Fédération Internationale des Traducteurs

See the following:

• Creating Local Glossary

• Opening Local Glossaries
• Adding Local Glossaries

• Importing Local Glossary
• Connecting Remote

Glossary

• Exporting Local Glossaries

Creating Local Glossary

You can add a new local glossary by creating one through the Project Terminology tab

To create a local glossary:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Create Local.
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The Create Glossary dialog box appears.

 5. Enter a unique name for this new glossary.
 6. Select the Target Language.
 7. Browse to a folder where the new glossary is to be saved.
 8. Optional: Select Read Only to prevent changes to the glossary.
 9. Click OK.

Adding Local Glossaries
 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Add Local.

The Browse For Folder dialog box appears.
 5. Select the glossary folder.
 6. Click OK.

The glossary is added and the Project Terminology tab reloaded with the added glossary showing.

Connecting Remote Glossary

You can use a remote glossary by connecting it through the Project Terminology tab.

To connect to a remote glossary:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.



Chapter 7 - Working With Terminology Wordfast

Copyright © Wordfast, LLC 2016.   Page 80 of 217

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Connect To Remote.

The Connect to Term Manager dialog box appears.
 5. Click the TMGR Server tab.
 6. Enter a unique name in the Name field.
 7. Select a target language from the drop-down list.
 8. Enter the URL (provided by the PM) in the URL field following the example template shown in that

field.

  Note:

The URL settings are populated automatically as provided within the URL string.

 9. Click Read Only to prevent modifications.
 10. Click Create Blacklist Connection to include a blacklist.
 11. Click OK.
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To connect to a remote WF Server click the WF Server tab and supply the information as described
above.

Opening Local Glossaries

To open a local glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Open Glossary.

The Glossary Editor tab appears.
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Importing Local Glossary

You can add a glossary or add to an existing glossary in a project through the Project Terminology tab.

To import a glossary or to add to an existing glossary:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Select the glossary to import.
 5. Click Import Glossary (shown above).
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The Import Glossary dialog box appears.

 6. Select a file type from the two options:

• Tab delimited text file (.txt)—Wordfast Classic and Wordfast Pro 3 format

• Term Base eXchange (.tbx)

 7. Enter or browse and select a glossary.
 8. Select one of the following options:

• Create New Glossary to import the first terminology file for the project

• Import Into Existing Glossary to add terms to the existing glossary
 9. Click OK to save the glossary changes.

Exporting Local Glossaries

To export a local glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
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 2. Select and open the project.
 3. Click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Select a glossary.
 5. Click Export Glossary.

The Export Glossary dialog box appears.

 6. Re-select the Glossary name (if necessary).
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 7. Select one of the following export types:

• Tab delimited text file (.txt)—Wordfast Classic and Wordfast Pro 3 format

• Term Base eXchange (.tbx)

 8. Enter the new file name and/or browse for a location to receive the glossary.
 9. Click OK.

The glossary is exported and saved at the specified location.

Working With Blacklists

A blacklist is a list of terms used in conjunction with Transcheck to ensure that unwanted terms are not
used in translation. Refer to the following tasks for adding and editing a blacklist.

• Creating Local Blacklists

• Importing Local Blacklists
• Adding Blacklists

• Exporting Local Blacklists
• Opening Local Blacklists

References:

• Modifying and Removing Glossaries, Blacklists

Creating Local Blacklists

You can create a local blacklist by adding it through the Project Terminology tab.

To create a local blacklist:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Create Local in the Blacklist group of the Project Terminology tab.

The Create Blacklist dialog box appears.

 5. Enter a unique name for this blacklist.
 6. Select a language.
 7. Browse to the destination folder.
 8. Select Read Only if the list is to be locked to prevent changes to the blacklist.
 9. Click OK.
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Adding Blacklists

A blacklist includes words or phrases that should not be used in the target segment.

To add a blacklist from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Add Local.

The Creating Blacklist browse dialog box appears.
 5. Browse for and select the blacklist folder to be added.
 6. Click Select Folder.

The newly created or selected blacklist is listed under Blacklists.
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Opening Local Blacklists

To open a local blacklist from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Select a blacklist.
 5. Click Open Blacklist (shown above).

The Blacklist Admin dialog box appears.

  Note:

To resize a column, point to the right edge of the column's header with the mouse and a pair of
opposing arrows appear separated by two vertical bars. Drag to increase or decrease the column.

To modify a given blacklist's Read Only status refer to Modifying Local Blacklists.

Importing Local Blacklists

You can add a local blacklist to a project by importing it through the Project Terminology tab.

To import a local blacklist:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Import Blacklist (shown above).

The Import Blacklist dialog box appears.

 5. Select the File Type.
 6. Browse and select the Import File.
 7. Select to create a new blacklist or add to a blacklist.
 8. If adding, select the existing blacklist from the drop-down list.
 9. Select how to handle duplicate terms.
 10. Select to Clear before import replace the existing blacklist.
 11. Click OK.
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Exporting Local Blacklists

You can export a local blacklist through the Project Terminology tab.

To export a blacklist:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Click Export Blacklist (shown above).

The Export Blacklist dialog box appears.

 5. Browse to or enter the path and file name of the blacklist to export.
 6. Click OK.

A confirmation pop-up appears at completion.
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Modifying and Removing Glossaries, Blacklists

The Options group of the Project Terminology tab includes the tools to modify and remove glossaries
and blacklists. These tools are:

• Modifying Local Blacklists

• Modifying Local Glossary
• Removing Local Blacklists

• Removing Local Glossary

Modifying Local Blacklists

You can change the Read Only status of a blacklist from the Project Terminology tab.

To change the Read Only status of a blacklist:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Select a blacklist.
 5. Click Modify.
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The Modify Blacklist dialog box appears.

 6. Select Read Only to prevent changing the blacklist.
 7. Click OK

Removing Local Blacklists

Local blacklists can be removed from a project through the Project Terminology tab.

To remove a selected blacklist from a project:

 1. Go to the Projects list tab (refer to Opening Projects)
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Select a blacklist.
 5. Click Remove.

A remove confirmation pop-up appears.

Optionally: This warning can be turned off by:

• Select Do not warn me... to avoid this pop-up in the future.

• Click Yes to complete the removal.

Modifying Local Glossary

To change a local glossary's Read Only status from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab opens.

Reference: Project Terminology Search and Sort.
 4. Select the glossary to modify.
 5. Click Modify.

The Create/Modify Glossary dialog box appears.
 6. Select Read Only to prevent further modifications.
 7. Click OK to complete the removal.

Removing Local Glossary

A local glossary can be removed from a project through the Project Terminology tab.

To remove a local glossary:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

Reference: Project Terminology Search and Sort.
 4. Select the glossary to be removed.
 5. Click Remove.

A remove confirmation pop-up appears.

Optionally: You can turn off this warning pop-up by:

• Select Do not warn me... to avoid this pop-up in the future.

• Click Yes to complete the removal.
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Reports 8
The Reports tab provides the lists existing reports for access and management.

Project Reports Search and Sort

The Report Name and Location columns can be ordered by typing the first letter or two of the item to
head the list then clicking the Sort Order arrows on the far right. These columns can be searched by
typing in a string of characters that are contained in the entry of interest. When a matching, unique string
is found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon.
(Reference Project Files Perspective.)

Project Reports Tasks

The tasks to view and manage project analysis and clean up reports are:

• Opening Reports • Exporting Reports • Removing Reports

Opening Reports

To open a report from the Reports tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Reports tab.
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The Reports tab appears.

Reference: Project Reports Search and Sort.
 4. Select a report to open.
 5. Double-click the selected report file.

The report file summary appears (as shown).
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Exporting Reports

The Reports tab includes an option to Export reports in a given project to a number of formats.

To export reports from the Reports tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select the Reports tab.

The Reports tab appears listing all reports found in the selected project.

Reference: Project Reports Search and Sort.
 4. Select a format from the drop-down menu (shown in the preceding example).

The export formats available are:

• Export report as CSV format

• Export report as HTML format

• Export report as XLS format

• Export report as PDF format

The Save As dialog box appears.

 5. Provide a folder path and file name for the report.
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 6. Click Save.

The report is saved in the identified folder under that file name provided.

Removing Reports

The Reports tab includes an option to remove unwanted reports from a given project.

To remove unwanted reports from the Reports tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select the Reports tab.

The Reports tab opens listing any reports found in the selected project as shown.

Reference: Project Reports Search and Sort.
 4. Select a report to delete.
 5. Click Remove Report.
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Project Reference Files 9
Reference files can be included with a project to provide context to the translation effort or to include
additional information that is not to be translated.

Project Reference Files Search and Sort

The File Name and Location columns can be ordered by typing the first letter or two of the item to head
the list then clicking the Sort Order arrows on the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon.
(Reference Project Files Perspective.)

Project Reference Files Tasks

The Reference Files tab includes the following tasks:

• Adding Reference Files

• Opening Reference Files
• Showing Instructions

• Removing Reference Files

Adding Reference Files

To add reference files from the Reference Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Reference Files tab.
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Reference: Project Reference Files Search and Sort.
 4. Click Add Files.

The Open file dialog box appears.

 5. Select the file to add.
 6. Click Open.

Opening Reference Files
 1. Go to the Projects list tab (refer to Opening Projects).
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 2. Select a project.
 3. Click Open Project.
 4. Click the Reference Files tab.

Reference: Project Reference Files Search and Sort.
 5. Select a file.
 6. Click Open File.
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The selected file opens in Microsoft Word.
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Showing Instructions

When a submission is created in Project Director using Add Submission on the Submit tab, specific
instructions can be attached to the submission for the translator and reviewer. These instructions are
then available for viewing through the Reference Files tab Options group.

To show the opened project instructions from the Reference Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Reference Files tab.

The Reference Files tab appears.

Reference: Project Reference Files Search and Sort.
 4. Click Show Instructions.

Instructions are optional and frequently there are no instructions and No instructions appears.

  Note:

Instructions can only be added from within Project Director.
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The instructions file list appears.

 5. Click OK.

Removing Reference Files

To remove files from the opened project through the Reference Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Reference Files tab.

The Project Reference Files tab appears.

Reference: Project Reference Files Search and Sort.
 4. Select the reference file to remove.
 5. Click Remove File(s).

The selected file is removed from the project and the reference file list.
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Translating Files 10
After completing the initial steps of creating a project, opening Translation Memory, and importing a
glossary the project is ready for translation.

Translation Tasks

The translation process includes the following tasks:

• Opening and Translating a File

• Using Glossaries

• Finding and Replacing Content

• Using Notes

• Using Transcheck

• Enabling Auto-Propagation

• Leveraging Repetitive Content

• Using Translation Memory

• Working with Tags

• Using Table Filter

• Working with Segments

• Enabling Machine Translation

• Using Auto-Suggest

• Saving Files

Opening and Translating a File

Translation involves opening the file to be translated and then submitting it to translation.

• Opening and Translating Files • Pseudo Translation

References:
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• Translation Preferences • Accented Characters • Configuring Whitespace
Check

Opening and Translating Files

After a given project is opened , the various files that comprise the project are accessible from the
Project Files tab. When the project has numerous files, the files can be chained together into one
contiguous file, refer to Chaining Files.

To open a file for translation from the Project Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.

Reference: Project Files Search and Sort.
 3. On the Project Files tab, select the file to translate.
 4. Click Translate File.
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The file open progress is shown and, upon completion, the TXLF Editor tab appears. The file content
is shown in the Source column.

 5. Select a Target segment.
 6. Enter the translation for this segment.

All tags in the Source segment should be either copied or entered manually into the Target segment.
 7. Click Next Segment to move down one Target segment.
 8. To save your work:

a) Click the File tab.

b) Click Save.

When the translation is complete, the file should be saved as described in Saving Files.

Chaining Files

Multiple files can be combined and viewed as one file using Chain Files. For example, if you are
assigned ten files with ten segments each, these files can be chained into one large file of 100 segments
and opened as one file.

To chain a group of files into one file from the Project Files tab:
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Reference: Project Files Search and Sort.

 1. Select the files to be chained.
 2. Click Chain Files.

The chained file opens in the TXLF Editor Translation tab under the name "Chained Files 1" (in this
example). In the Source Segment Column, the segments are numbered as they were in the source
file. The source ID for each segment from a given file is sequentially numbered and the ID is given a
unique background color. Subsequent file segments are numbered in the same manner with a unique
background color.

 3. Click in segment three (3).
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Notice the file name changes to the name of the first file in the chain.

 4. Scan down the segments until segment ID-1 appears again and the ID background color changes.
 5. Click in segment one (1).

Notice the file name changes to the name of the second file in the chain.

 6. Scan down the segments until segment ID-1 appears again and the ID background color changes
again.

 7. Click in segment one (1).

Notice the file name changes to the name of the third (last) file in the chain.

 8. Save the chained file.
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When the chained file is saved, the segments are restored to their original files and the chained
format is not retained.

  Note:

Multiple of sets of chained files can be opened as well.

Chaining files is only for the editor view and they cannot saved as TXLF export documents.

The Jump To A Segment and Last Modified Segment shortcuts are disabled on chained files.

Translate All

To translate a project file from the Translation tab using Translate All:

 1. Click in the first source segment.

 2. Click Translate All.

The translation proceeds and upon completion the screen is refreshed with the results and the green
bar at the bottom indicates the percentage translated.
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Using Translation Memory

Translation memory (TM) is designed to provide maximum content re-use and facilitate collaboration
between globally distributed localization resources. The following is a list of those tasks and associated
procedures:

• Leveraging Translation Memory • Using TM Lookup

Leveraging Translation Memory

To leverage Translation Memory from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select the file to translate.
 4. Click Translate File on the Project Files tab.

The file is leveraged against the Translation Memory and the results displayed in the Target
Segment column, segment by segment.

 5. Select the segment to leverage from the Source column.
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 6. In the Segment or Automated Actions group of the Tools ribbon on the Translation tab, click one
of the following:

• Leverage to retrieve suggestions from the active TM for the selected source segment

• Until Fuzzy to retrieve suggestions from the active TM until the next Fuzzy match

• Until No Match to retrieve suggestions that from the active TM for the all source segments until
no exact match is found

• Translate All to automatically translate all segments.

The leveraged content appears in the Target column when a match is found. When Machine
Translation is enabled, the Machine Translation match is populated.

In the following example, source segment ID-4 is selected and after clicking Leverage the adjacent
target segment is populated with leveraged translation.

Using TM Lookup

The Translation Memory lookup is used to view TM leverage results and concordance search results.
This search looks for specific source segment text in the translation memory. The results show source
and target segments.

Translation Memory leverage search occurs automatically, as a user navigates through the segments, to
provide the users with the best possible full segment matches from the TM. It is also the only search that
uses scoring to decide which match is the best.
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To perform concordance search from the Translation tab:

 1. Enter a word or phrase in the TM Lookup text box as shown in the following example.

Using the string "vendor" searches segments ignoring case and includes matches containing any of
the specified words.

 2. Click Find Source or Find Target.

Without using a case sensitive search there are numerous hits.

 3. To further refine the search, using the string VENDOR, select Case Sensitive under More Options.

More Options drop-down.

Option Description

Case Sensitive Filter by case.

Exact Filter for only those terms that appear in the same order.
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Option Description

Automatic Leverage Filter for TUs that are matched in the TM.

Diff Highlight Highlight the difference between source and TM source as well as
differences between target and TM target.

Include Private TU (GLTMS) Include private Translation Units in the search for remote GLTMS
TMs.

Rerunning the search with Case Sensitive selected returns only one hit as shown in the following
example.

Using Glossaries

Glossaries are lists of source terms and their preferred translations. To set up a glossary refer to Working
With Terminology.

When a segment, under the Terminology tab, is selected all terms within that segment that are in the
glossary are highlighted and shown with their translation word in the Terminology pane. Using the Next
Term and Previous Term buttons moves the focus through all terms within that segment that are found
in the glossary.



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 116 of 217

Editing the glossary from the Terminology pane:

• Add a term to the glossary, refer to Adding Glossary Terms

• Edit a term in the glossary, refer to Editing Glossary Terms

• Remove a term from the glossary, refer to Removing Glossary Terms

• Insert a term into the the target segment, refer to Inserting Glossary Terms

Adding Glossary Terms

Adding terms to a glossary from the Terminology tab:

 1. Do one of the following:

• Select a word in the source segment and the translation in the target segment
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•
◦ Click the Add Icon, in the Terminology pane.

Add icon: 

• The Add Term dialog box appears. 

• Or, select a term in the source segment

◦ Click the Add Icon, in the Terminology pane.

Add icon: 

• The Add Term dialog box appears. 

◦ Enter the translation for the term in the Target field
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 2. Click OK.

Editing Glossary Terms

Editing terms in a glossary from the Terminology tab:

 1. Select the term to edit.
 2. Click the Edit Icon in the Terminology pane.

Terminology pane:

Edit icon:

The Edit Term dialog box appears.

 3. Make the editorial changes.
 4. Click Modify.

Removing Glossary Terms

Deleting terms in a glossary from the Terminology tab:

 1. Select the term to delete.
 2. Click the Remove Icon in the Terminology pane.

Terminology pane:
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Remove icon:   .

A Remove confirmation pop-up appears.

 3. Click Yes.

Inserting Glossary Terms

Inserting a term into the current target from the Terminology tab:

 1. Click in the target segment where the insertion is to take place.
 2. Select the term to insert from the Terminology tab.
 
3. Click the Insert Icon,  in the Terminology pane.
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The selected term is inserted into the target segment at the selected point.

Working with Tags

A tag is inline text that is wrapped in a special character pair and is not translatable. For example, HTML
code tags within a sentence. Target segments should have the same tags as the source segment.
However, depending on the language, sometimes a tag is not needed. If an attempt is made to save a
target segment with missing tags, a warning message appears.

Below is a list of the tag related tasks:

• Viewing Tags

• Copying Tags
• Clearing All Tags

• Deleting Tags
• Editing Tags

Viewing Tags

To view tags from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
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 3. Select a file for translation.
 4. Click Translate File.
 5. Click the Translation tab.

The file appears under the Translation tab. If tags exist in the source segment, they appear in purple
if they are formatting tags and gray for non-formatting tags. The first tag in a selected segment
appears in red.

The tags in the source segment are highlighted. For example, the numeral one in highlighted in red to

indicate selected ( ) is a tag and should be copied into the target segment.
 6. Mouse over a tag to view the tool-tip information as shown in the following example.

The text as it appears in the tag is shown in the following tool-tip snippet.

Copying Tags

Tags can be selected and copied individually (Copy).

 1. Click Translate File on the Project Files tab.
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 2. To copy tags from the Translation tab, select the tag to be copied.

 3. Drag the selected tag into the target segment or click Copy.
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The source and target segments are highlighted. Once the tag is copied, the next tag is automatically
selected.

The tag is highlighted in red and selected as shown in the following example.

 4. Click Copy All Tags in the Tags group of the Translation tab to expand the drop-down menu.

The Copy All Tags menu appears as one of the two shown.

  

a) Select one:

• Segment to copy only the tags for the selected segment to the target
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• Document to copy all tags for the entire document

b) Enter the translation between the copied tags, if necessary.

Copied tags appear at the location of the cursor. They must be reordered to appear correctly.

c) Drag and drop the translated text, or cut and paste the translation between the tags.

Editing Tags

To edit tags from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select a file for translation.
 4. Click Translate File.

The file appears under the Translation tab.
 5. Select a segment to edit.

If tags exist in the source segment they are shown.
 6. Highlight the tag to be edited in the target segment as shown in the following example.

 7. To open the Edit Tag dialog box, right-click on the tag and select Edit Tag from the drop-down menu.

Reference: Translation Edit Drop-down Menu

  Note:

Tags in the source segment should not be edited.

Ensure that all tag edits are valid, otherwise the TXLF file could become corrupt.
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The Edit Tag dialog box appears.

 8. Make the tag modifications.
 9. Click OK.

Deleting Tags

The tag can be deleted only in the target segment.

To delete tags:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open a project.
 3. Select a file.
 4. Click Translate File.
 5. Click the Edit tab.
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The file content appears in the Translation workspace. If tags exist in the source segment, they
appear in purple if they are paired tags and gray for non-paired tags. The first tag in a selected
segment appears in red.

 6. In the target segment of the Translation dialog box, select the tag for deletion.
 7. Select the tag to delete with a cursor scan.
 8. Delete the tag by doing one of the following:

• Press Delete

• Click Cut on the Options ribbon

• Press Backspace

Reference: Translation Edit Drop-down Menu

The Undo option is available on the Options ribbon.

Clearing All Tags

Tags can be cleared only from a target and either the current segment or from the entire document.

To clear all tags from the current target segment through the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select a file.
 4. Click Translate File.
 5. Click the Translation tab.
 6. Place the cursor within the target segment.
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 7. Click Clear All Tags.
 8. Select one of the following:

• Segment from the drop-down menu to clear all tags from the segment

• Document from the drop-down menu to clear all tags from the document

    

  

A warning pop-up appears.

 9. Click Yes to complete the removal.
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Finding and Replacing Content

Text in translated content can be searched for and replaced using the Find / Replace option.

To find and replace text in a file from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Edit tab.

The Edit tab appears.

 4. Click Find/Replace.

The Find/Replace dialog box appears.

 5. Under the Find tab, enter the search text in the Find What: field.
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  Note:

Search arguments can include non-breaking spaces.

 6. Click Find Next repeatedly to move through all occurrences of the term.
 7. Select Reading Highlight to toggle the highlighted term in the submission.

Find/Replace dialog box.

Replace Tab Option:
 8. Select the Replace tab to replace terms.
 9. Enter the find text and replacement text.
 10. Click one of the following:

• Replace, to replace the found content only

• Replace All, to replace the found content and all other instances of that content

• Find Next, to move to the next instance of the term

Replacing text in Find/Replace dialog box.

More Options:
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Option Description

Backward Search from cursor location to file beginning.

Forward Search from cursor location to file end.

Ignore Case Search for all instances of a word or phrase ignoring case.

Whole Words Only Search for all instances of only whole word matches.

Ignore Non-breaking Space
Search for all instances of a word or phrase including non-breaking
spaces.

Search Source Search for all instances of a word or phrase in the source only.

Search Target Search for all instances of a word or phrase in the target only.

Search Through Open Files Search for all instances of a word or phrase in all open files.

Using Table Filter

The Table Filter option provides the means to search for specific text using a number of filter criteria.
The Translation tab is shown with the search bar bordered in red.
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An explanation of the Table Filter toolbar (shown above) is presented in the following table.

Item Description

The Source/Target filter menu options are:

• Source restricts the search to the source language segments.

• Target restricts the search to the target language segments.

• Source and Target directs the search to both source and
target.

• Source or Target directs the search to either source or target
(default).

Directs search to be case-sensitive.

Drop-down list field Specify the text that is the object of this search.
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Item Description

Drop-down list of all available search filter criteria:

• 100% match segments– segments matching completely in TM

• All except 100% and In Context match segments– segments
with partial TM match, no match, or modified segments

• Auto-propagated segments– all auto-propagated matches

• Committed segments– segments with translated content
committed to the TM

• Context match segments– all segments matching context

• Duplicate segments– segments being duplicated in the file

• Edited source segments– source segments that have
changed

• Empty target segments– segments without a translated target

• Fuzzy match segments– segments with partial TM match

• Machine translated segments– segments translated by
machine—Note: requires Machine Translation be enabled in the
project.

• Modified segments– segments modified through auto-
propagation

• No match segments– segments with no match in the TM

• Segments with transcheck warnings– segments with non-
linguistic errors or repeated words

• Segments with history– segments with a change list

• Segments with notes– segments containing comments

• Segments with repetitions– segments with repeated text
strings

• Short segments– segments of fewer than {#} words,
paragraphs or other blocks

• Unconfirmed segments– segments marked unconfirmed

Apply the selected filter.

Accumulate a selection of filters to apply in order of selection

Clear all fields in Table Filter tool bar



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 133 of 217

Item Description

Sort the filtered results by selected criteria where Document is
selected by Default

Configure options for the Table Filter using the dialog box (shown in
the following graphic*) to enter a maximum word count

* The Table Filter pop-up dialog box.

Using Notes

While translating or reviewing translated content, notes specific to each segment can be added as
described here.

Wordfast Pro opens in the Projects tab. Double-clicking a project opens the Project Files tab. For
additional information refer to Opening Projects.

A project's notes are accessible through the Review tab after a project file is opened.
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Begin with the Review tab where the following Notes options are available:

• Viewing Notes

• Adding Notes
• Editing Notes

• Deleting Notes
• Exporting Notes

Viewing Notes

To view notes from the Review tab:

 1. Select the file where notes are to be viewed.
 2. Double-click a file or click Review File.
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The file appears under the Translation tab.

Notice the Note icon in the status column of the third segment.
 3. Click the Notes tab in the lower-left portion of the screen, Editor Tabs work area.

The attached notes are listed in this work area as shown in the following segment of the TXLF Editor.

Adding Notes

You can add notes as needed from the Review tab.
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To add a note from the Review tab:

 1. Place the cursor in the segment where the note is to be added.
 2. Use one of the following methods to open the Notes dialog box:

• Click Add in the Notes group of the Review tab.

• Click Add under Notes tab of the Editor.

• The Add/Edit Notes dialog box appears.

• Right-click the segment and click Add.
 3. Select the note Type.
 4. Enter the note text.
 5. Click OK.
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The note appears in the Editor Tabs work area under the Notes tab while the Notes icon appears in
the Status column.

Editing Notes

You can edit existing notes through the Review tab.

To edit a note:

 1. Place the cursor in the segment where the note is to be edited.
 2. Select the note to be edited.
 3. Use one of the following methods to edit the note:

• Click Edit in the Notes group of the Review tab.

• Click Edit under Notes tab of the Editor Tabs section.

• Right-click the segment and click Add.

The Add/Edit Notes dialog box appears.
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 4.  Edit the note.
 5. Click OK.

The modified note appears in the lower left of the screen in the Editor Tabs section under the Notes
tab.

Deleting Notes

You can delete notes through the Review tab.

To delete notes:

 1. Select the segment where the note is to be deleted.
 2. Select the note to be deleted.
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 3. Use one of the following methods to delete the note:

• Click Delete in the Notes group of the Review tab.

• Click Delete under Notes tab of the Editor.

• Right-click the segment and click Delete.

Exporting Notes

You can exports notes in Microsoft Word format through the Review tab.

To export notes:

 1. Click the Review tab.
 2. Select the note(s) to export.
 3. Click Export.
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The Export Notes dialog box appears.

 4. Verify or change the save folder.
 5. Enter a name for the file.
 6. Select the Microsoft Word file type.
 7. Click Save.

The file is saved in the specified location and can be reviewed by browsing to the note file and
opening it.

Working with Segments

Segments are parts of the file that are divided by formatting or punctuation. Typically, segments are
sentences, but may be words or numbers, depending on the formatting of the source file. When a file
is converted to a translatable TXLF format, all complete sentences become separate segments. Once
these segments are translated, they are saved and committed to the Translation memory and leveraged
in future translations. Translation Memory leveraging reduces the time and expense of future translations
by automatically and consistently translating reoccurring words and phrases.

Refer to the following tasks:
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• Viewing Segment History

• Committing to Translation Memory

• Unconfirming and Confirming
Segments

• Copying All Sources

• Locking Segment

• Clear Target

• Copying Source

• Clear All Targets

• Editing Source
Segments

References:

• Leveraging Translation Memory

Viewing Segment History

The Segment History tab is used to view the segment changes in the currently open file. In the following
example, the segment was modified twice on the same day.

Committing to Translation Memory

After translating all the source segments, Translation Memory should be updated. The changes must be
committed to the Translation Memory. The Commit All tool should be used to update all target segments
from TM. The Commit tool only updates the current target segment from TM.

To update Translation Memory use Commit All as follows:
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 • Click Commit All in the Translation Memory section.

The Translation Memory is updated for the current segment (Commit) or the entire document
(Commit All).

Copying Source

Source can be copied to targets from the TXLF Editor Translation tab using Copy Source.

To copy segment source text to the segment target:

 1. Select a source segment.

The associated target segment is highlighted based on that color selected within Preferences >
Colors.

 2. Expand Copy Source options.

• Click a Copy Source option:
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The source segment is copied to the target.

 

 

Copying All Sources

All source content can be copied into all targets from the TXLF Editor Translation tab (as shown) using
Copy All Sources.

To copy all source segments to the all target segments:

 • Click Copy All Sources.

Locking Segment

Confirmed, proofed, and translated segments can be locked to ensure that they are not changed.
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To lock a segment:

 1. Open the TXLF Editor Translation tab as shown.

 2. Select the segment to lock.
 3. Click Lock Segment.

The Locked Segment icon appears in the Status column of the selected segment.

Clear Target

You can clear selected target segments through the Clear Target tab.
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To clear the selected target content:

 1. Select the target segment.
 2. Click Clear Target.

A confirmation warning appears.

 3. Click Yes to complete the target clearing.

Clear All Targets

All target content in a file can be cleared from the TXLF Editor Translation tab using Clear all Targets.
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 1. Click Clear All Targets.

A confirmation warning appears.

 2. Click Yes to complete the clearing.

Unconfirming and Confirming Segments

The Unconfirm/Confirm Segment option allows the translator to mark a segment for future reference. For
example, if the translator wants to check and confirm a segment after referring to some resources, the
segment can be marked unconfirmed.



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 147 of 217

Unconfirmed segments cannot be committed to the TM.

Individual segments can be unconfirmed or confirmed in separate actions through the TXLF Editor
Translation tab (refer to Opening Projects). All segments can be confirmed in one action. See the
following:

• Unconfirming or Confirming a Segment

• Unconfirming or Confirming All Segments

Unconfirming or Confirming a Segment

To unconfirm or confirm a segment from the Translation tab:

 1. Select and open the project.
 2. From the Project Files tab, double-click the file.
 3. Click the Translation tab.
 4. Enter a translation, or leverage the target segment from the Translation Memory by clicking the TM

Lookup tab in the lower left portion of the screen.

The target segment appears.

 5. Click Unconfirm / Confirm on the tab.

The Unconfirmed icon appears next to the segment in the Status column (shown above).
 6. To confirm the segment, click Unconfirm/Confirm on the tab.

The Unconfirm icon is removed from the Status column.
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Unconfirming or Confirming All Segments

To unconfirm or confirm all segments from the Translation tab:

 1. Select and open the project.
 2. From the Project Files tab, double-click the file.
 3. Click the Translation tab.

The file appears in the Translation workspace. The first translatable segment appears in a blue
background and the cursor is placed in the target segment.

 4. Enter a translation for each segment, or leverage the target segments from the Translation Memory.
 5. Click the Unconfirm / Confirm All drop-down menu.
 6. Click one of the following:

• Unconfirm All

• Confirm All
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The Unconfirm icon appears next to the segments in the Status column when Unconfirm All is
selected in the previous step, as shown in the following example.

 7. Click Confirm All to reverse the Unconfirm All.

Editing Source Segments

The Edit Source option allows you to modify the source content of the file being translated. The original
source content is stored in the TXLF file and can be restored at any time.

To edit the source segment from the Edit tab:

 1. Double-click the file.

The file appears on the TXLF Editor Translation tab.
 2. Select a segment.
 3. Click the Edit tab.
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The TXLF Editor Edit tab appears.

 4. Place the cursor within the segment source.
 5. Click Edit Source in the Source Actions section.
 6. Edit the source content as needed.
 7. Click off the edited segment.

The screen segment highlights the symbol used to indicate an edit took place and an Edited Source
icon appears in the Status column.

To revert to original source, click Revert Source in the Source Actions section.

Accented Characters

The table below lists the letters with supported accents.
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Accent Sample Key Combination Notes

Acute Ó ó Ctrl+', V '= apostrophe key

V= any vowel

Circumflex Ô ô Shift+Ctrl+^, V

Grave Ò ò Ctrl+`, V

Tilde Ñ ñ Shift+Ctrl+~, V Only works with "n, N, o, O, a, A"

Umlaut Ö ö Shift+Ctrl+:, V := colon key

Some examples follow:

1. To enter the character "ó", (Ctrl+',o) hold down the Control key and press the apostrophe key.
Release both keys and press "o". The accented letter appears.

2. To enter the character "Ó", (Ctrl+',O) hold down the Control key and press the apostrophe key.
Release both keys and press "O". The accented letter appears.

3. To enter character "ñ", (Shift+Ctrl+~,n) hold down the Shift key and press the Control key, then
press the tilde (~) key. Release all three keys and press "n".

The following table lists other supported foreign characters.

Character Name Key Combination Notes

¡ Upside-down exclamation
point

Alt+Shift+Ctrl+!  Press and hold Alt+Shift+Ctrl+!

¿ Upside-down question mark Alt+Shift+Ctrl+?  

Ç, ç French C cedille (caps/
lowercase)

Ctrl+, ,c

Ctrl+, ,C

For ç, press Control, then the comma
key. Release then press c.

Œ, œ OE ligature (caps/
lowercase)

Shift+Ctrl+&,o

Shift+Ctrl+&,O

Press and hold Shift+Ctrl+&, release
the keys and press o

ß German Sharp/Double S Shift+Ctrl+&,S

Ø, ø Nordic O slash (caps/
lowercase)

Ctrl+/,o

Ctrl+/,O
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Character Name Key Combination Notes

Å, å Nordic A-ring, Angstrom
sign (caps/lowercase)

Shift+Ctrl+@,a

Shift+Ctrl+@,A

A with ring/Angstrom Sign

Æ, æ Old English AE ligature
(caps/lowercase)

Shift+Ctrl+&,a

Shift+Ctrl+&,A

Ð, ð Old English eth (caps/
lowercase)

Ctrl+',d

Ctrl+',D

Icelandic/Old English eth

' = apostrophe key

Using Transcheck

The Transcheck option verifies certain elements in the target segments and warns about missing or

incorrect text or variables. For example, if a tag or type text is incorrectly entered, a warning icon ( )
appears before the target segment. When you mouse over the warning, details appear.

The following are the related tasks:

• Enabling Transcheck

• Running Transcheck All
• Viewing Transcheck Warnings

Enabling Transcheck

Transcheck options are tied to a specific project. To enable Transcheck and customize the options for a
project refer to Configuring Transcheck.

Running Transcheck All

The Transcheck All Segments scans all segments of a file for non-linguistic errors in the target
segments and warns about missing and/or incorrect text. This should be done before completing a file.

To check all segments of a file from the TXLF Editor Review tab:

 1. Select the file to be checked.
 2. Click the Review tab.
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The Review tab of the TXLF Editor appears.

 3. Click Transcheck All.

All segments of the file are checked and a Transcheck report is generated.

Transcheck All Reports

After Transcheck is run on all segments, two reports are generated. The detailed Transcheck report
opens in a separate Web page and the summary is shown in a Transcheck Report pop-up.

The detailed Web report opens as shown in the following example, as long as pop-ups are not blocked
by the browser.
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Detailed Transcheck Report (page 1)
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Detailed Transcheck Report (page 2)
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Detailed Transcheck Report (page 3)

Summary Transcheck Report
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Viewing Transcheck Warnings

Warnings generated when running Transcheck can be viewed under the Transcheck tab in the lower-
left area if Transcheck during translation is selected in Transcheck Preferences (refer to Configuring
Transcheck).

To view Transcheck warnings from the TXLF Editor Files tab:

 1. Select a file.
 2. Click Translate File.

The file is validated and displayed in a TXLF Editor Files tab.

 3. Click the Review tab.
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 4. Click Transcheck All.

A summary of errors found is presented in a pop-up.

 5. Click in the first target segment.
 6. Click the Transcheck (1) tab in the lower left area of the screen, referred to as the Editor Tabs work

area.

The "(1)" indicates the number of errors found in the selected segment.



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 159 of 217

The Transcheck warnings are shown there as the segments are stepped through.
 7. Navigate to next segment by clicking Next error under the Transcheck tab.

As each segment is clicked, any warnings for that segment appear in the Editor Tabs work area
under the Transcheck tab

 8. Do one of the following:

• Correct the error and click Refresh

• Click Ignore warning to continue reviewing the warnings without changes

If the error is not corrected, the Transcheck error icon remains in the Status column and under the
Transcheck tab in the Editor tabs area.

Enabling Machine Translation

Wordfast Pro includes an automated machine translation feature that populates translations whenever
a file is open or when there are no Translation Memory segment matches. To enable specific Machine
Translation options, refer to Configuring Machine Translation.

Enabling Auto-Propagation

Translations for segments can be set to propagate in the document automatically when a segment
is committed to Translation Memory. Enabling the Auto-Propagation option permits the leveraging
of repetitive content from previous translations. For more information, refer to Configuring Auto-
Propagation.

Using Auto-Suggest

The Auto-Suggest option populates suggestions based on source content, such as numbers, URLs and
proper names. It can also suggest terms for the glossary, Translation Memory (TM) matches, and sub-
segment TM matches. To enable this option see Configuring Text Tools.

Leveraging Repetitive Content

Leveraging repetitive content re-uses segments that are repeated in a file. In the following example
there are multiple instances of the phrase Seamless Database Integration..., so when the translator
enters the translation the duplicate segment is likewise translated. So for duplicate segments you only
enter the translation once and the duplicate segments are leveraged, updated automatically when Auto
Propagation is enabled (refer to Configuring Auto-Propagation).

To leverage repetitive content from the TXLF Editor Translation tab:

 1. Select a file.
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 2. Click Translate File.

The file appears in the Translation workspace of the Translation tab.

 3. Select the first translatable segment. It changes to a blue background with the cursor in the target
segment.

In this example, the duplicate segments have been located with a filtered search.

 4. Enter the translation into the first segment.
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 5. Commit the term by using one of the following methods:

• Click Commit

• Click Next

The entered target segment is saved to the TM and automatically propagates this target segment for
all repeats of the source segment throughout the file.
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Saving Files

It is a good practice to save your work occasionally to prevent a loss before completion, options to save
files are available on the Files tab.

To save your work use one the options below:

 • In the Save Options group of the TXLF Editor File tab, click one of the following:

• Save to save the active file to  a local drive manually

• Save to save the active file to a local drive manually under a different name

• Save File As Translated to save the translated file to a local drive

A pop-up progress bar appears and upon completion, you will find the saved file on a local drive.
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Quick Tools 11
Quick Tools provides a collection of tools for users to create and work with files outside of projects.
These tools are primarily used by Project Managers before sending the files to translators.

 1. Open Wordfast Pro.

  Note:

The Projects, Location, Source Language, and Target Language columns can be ordered by

typing the first letter or two of the item to head the list then clicking  or  to the far right. These
columns can be searched by typing in a string of characters that are contained in the entry of interest.
When a matching, unique string is found in an entry, only that entry is presented in the list. To restore

the list, click the Clear Filters icon .
 2. Click the Wordfast 4 tab to expand the drop-down menu.

Refer to Starting Wordfast Pro for more information.
 3. Click Quick Tools.
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Refer to the following sections for more information on Quick Tools:

• To run a project file analysis, refer to Analyzing Project Files

• To clean up and update the Translation Memory, refer to Cleanup

• To preview what is translatable and the complexity of formatting in the target, refer to Pseudo
Translation

Analyzing Project Files

In analyzing a project's files for translation, the source files are analyzed against Translation Memory
and generates a report listing matches, non-matches, word count, and character count as well as the
total number of segments. This process can greatly improve efficiency while reducing the time and effort
spent by the translator.

The file Analysis can also create TXLF files from the source files that can then be sent to linguists for
translation.

Another use of the file Analysis is in generating quotes based on the word and character count.

Analysis can be accomplished in either of the following ways:
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• Analyzing an entire project from the Project Files tab, refer to Analyzing Projects

• Analyzing individual files of a project from the Quick Tools tab, refer to Analyzing Files

Analyzing Files

You can use Analyze Files from the Analyze tab of Quick Tools to analyze the selected file(s) against
Translation Memory, leveraging reusable content and performing a pre-translation.

To analyze files:

 1. Click the Analysis tab.

 2. Add the file(s) to be analyzed.
 3. Select the appropriate settings and provide export report information (refer to Configuring Translation

Memory).

a) Select the Translation Memory to use.

b) Select the Options:

• Fuzzy match threshold with the percent match

• Copy all tags
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• Copy source on no match

• Create TXLF files

• Enter a TXLF file location
 4. Select the Report Settings:

a) Calculate analysis report percentage by:

• Words

• Segments

b) Select to Calculate internal fuzzy matches with the percent match.

• Select Include internal fuzzy matches as TM matches

c) Select the report format from the drop-down list, in this case report summary.
 5. Click Analyze Files.
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A pop-up appears showing the report percentage progress.

The analysis completes and the Report File summary appears (shown below).

Cleanup

The Project Manager is responsible for the cleaning up of translated files and selecting the TM update
options. The file cleanup process requires a manual initiation.

Cleanup processes bilingual files (TXML files containing source and target). The source files are returned
to their original format and the bilingual files are converted to files in the target language using the
original format. (Refer to Working with Segments.)

Optionally, the TM can be updated during cleanup.

As a final step, a report is generated indicating the number of segments processed, errors encountered,
and TM update results.
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To clean up and update the Translation Memory using Quick Tools:

 1. Select Quick Tools from the Wordfast 4 drop-down menu.
 2. Click the Cleanup tab.

 3. Click Add File.

The file Open dialog box appears.

 4. Select a file.
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 5. Click Open.

The Cleanup tab reappears with the selected files.
 6. Optionally,

• select an Update Option for updating files to a Translation Memory

◦ The TM Update Options pull-down list.

• Select the Translation Memory to use.

  Note:

At least one Translation Memory is needed before file clean up can be initiated (refer to Working with
Project Translation Memory). To add a local or remote Translation Memory, refer to Creating Local
Translation Memory for more information.

 7. Click Clean Up.

A pop-up appears showing the percentage progress.

Upon completion, the CleanUp Report summary appears.
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Pseudo Translation

Pseudo translation copies the source content to a target where the content has accented characters
and the text is expanded by twenty percent. The pseudo translation provides a preview of what content
will be selected as translatable and how complex formatting appears in the target. Both source files and
TXLF files can be pseudo translated.

To pseudo translate files:

 1. Click Quick Tools in the Wordfast 4 drop-down menu.

The Quick Tools tab appears.
 2. Click the Pseudo Translation tab.
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 3. Select the file format for pseudo translation, to pseudo:

• Translate a TXLF file, select and add a TXLF file

• Translate a source file, select Source, and select the Pseudo translation Options
 4. To browse and select files from a folder, click Add File under File.
 5. To browse and select a folder click Add Folder under File.
 6. Select the files to be pseudo translated.

  Note:

Only one format can be selected at a time.

 7. Click Pseudo Translate.
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A confirmation pop-up appears upon completion.

  Note:

Up to 20 files can be processed at a time using Wordfast Pro in Demo mode. To pseudo translate
more than 20 files, a Wordfast Pro license is required.

The pseudo translated files are placed in the same folder as the source file. An example of a pseudo
translated TXLF file is shown below.
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Preferences 12
Much of the Wordfast Pro user interface is controlled by the preference options. You can tailor these
through Preferences and by pressing F9.

The preferences categories and sub-categories are listed below.

1. General Preferences:

• Customizing Colors

• Customizing Icon Appearance

• Customizing Shortcuts

• Customizing Fonts

• Customizing Application Layout

• Customizing Warnings

2. Translation Preferences:

• Configuring Tags

• Configuring Text Tools

• Configuring Machine Translation

• Configuring Auto-Propagation

• Configuring Spell Check

3. Current/New Project Preferences:

• Configuring Translation Memory

• Configuring Penalties

• Configuring Segmentation

• Configuring Terminology

• Configuring Transcheck

• Configuring Filters

4. User Preferences are the Advanced Settings as follows:

• Default Preferences Settings • Export/Import Preferences Settings
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General Preferences

General preferences cover the following topics:

• Customizing Colors

• Customizing Fonts

• Customizing Icon Appearance

• Customizing Application Layout

• Customizing Shortcuts

• Customizing Warnings

Customizing Colors

Varying colors are used to differentiate between types of content in the TXLF editor. This color usage
can be customized through Preferences—General Preferences.

To customize the color usage for translation from Preferences:

 1. Click Colors in the General Preferences group.

The current translation color settings appear.
 2. To change the color for any Item Name, click the colored image in the Color column.

For example, click the colored image in the Color column for item No Match and the color palette
appears.

• Select purple.

• Click OK.
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The color code for the selected item is changed to purple.

 3. Click OK to save the change(s) and close the Preferences.

Customizing Fonts

The fonts for the various application tools can be customized in the Preferences—Fonts section.
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The following tables list the standard fonts and associated sizes.

Application Specific Fonts

Application Font Name Font Size

TXLF (TXML) Editor Font Arial 13

TM Lookup Font Arial 12

Glossary Lookup Font Arial 12

Blacklist Editor Font Arial 13

Translation Memory Editor Font Arial 13

Terminology Editor Font Arial 13

Notes View Font Arial 12

Segment History Font Arial 12
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Application Font Name Font Size

Transcheck Font Arial 12

Adding Language Specific Fonts

Language Font

Bengali Bangla

Malayalam Kartika

Telugu Gautami

Tamil Latha

Kannada Tunga

Afrikaans Arial

Afrikaans (South Africa) Arial

Chinese SimSun

Chinese (Taiwan) PMingLiU

Chinese (China) SimSun

Hebrew Arial

Hebrew (Israel) Arial

Japanese MS Gothic UI

Japanese (Japan) MS Gothic UI

Korean Batang

Thai Tahoma

Thai (Thailand) Tahoma
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Language Font

Vietnamese: Arial Arial

Vietnamese (Vietnam): Arial Arial

Customizing Icon Appearance

The icons appearance on the various tabs can be modified to the extent of relative size and the inclusion
or exclusion of the icon title by navigating to Preferences then Icons as described below.

To customize the icon appearance from Preferences:

 1. Click Icons.

The two icon appearance options (relative size and title) appear.

 2. Select a preferred icon size.
 3. Select Display text to enable or disable the inclusion of description text with the icons.
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Customizing Application Layout

The layout preferences provide some control of the Editor view. Customize the general layout options by
navigating to Preferences then:

 1. Click Layout.

The layout preferences appear.

 2. Modify the layout options in the following criteria table.

Table View

Option Description

Hide ID Column Hide the segment ID column.

Hide Score Column Hide the Translation Memory score column.

Hide Table Header Hide the editor table header.

Score Column Position
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Option Description

Before Target Place the Translation Memory score column before the target
segment column.

After Target Place the Translation Memory score column after the target
segment column.

Segment

Option Description

Automatically leverage first segment View the Translation Memory leverage of the first open
segment when you open a TXLF file for translation.

Automatically open last edited
segment when opening a file

Go to the last segment edited when a file is opened.

Next/Previous Segment (TM
Commit) action leverages next/
previous segment

Enable or disable the writing and leveraging action of the
Next/Previous Segment command.

Skip Unedited 100% Matches Enable or disable skipping over those segments with perfect
matches.

Skip Unedited Context Matches Enable or disable skipping over those segments with context
matching.

Layout

Option Description

Keep the last layout open Always keep the previous edit view open.

Layout—Current Project

Option Description

Display Locale Codes in Current
Project View

Always include locale information in the view for current
projects.
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Option Description

Display Full Language Name in the
Current Project View

Always include the complete language name in the view for
current projects.

Status Bar—Current Project

Option Description

Language Codes Include the language codes on the Status Bar.

Full Language Name Include the complete language name on the Status Bar.

Customizing Shortcuts

Many of the tools of Wordfast can be associated with keyboard shortcuts.

To view the list of available shortcuts and select keyboard shortcuts, navigate to Preferences and then:

 1. Click Shortcuts in the General Preferences group.

The options list to customize keyboard shortcuts appears for the Application scheme.
 2. Select a scheme from the Scheme drop-down list.

 3. Select a Command from the command list.

In the example below, the Terminology Highlight shortcut is selected.
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 4. Select that command to access edit mode.
 5. Press the new sequence of keys Ctrl+Shift+F7 in the Shortcut column.

In the event that the shortcut key sequence is in use a warning pop-up appears.

The shortcut key is modified to that specified.

  Note:

When changing or creating new shortcut key sequences, the sequence must begin with a Ctrl, Alt, or
Shift, or must be a Function key (F1), a combination of these.

 6. Click OK.
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Customizing Warnings

The messages that are presented to the user can be limited to some extent. Most of the messages
—referred to here as warnings—are selected by default. To modify the warning inclusion list, select
or deselect the check box for a given warning to enable or disable that warning. To customize the
messages presented, navigate to Preferences.

To select warnings:

 1. Click Warnings.

The Warnings dialog box appears.

 2. Select the warnings to be displayed in the application.



Chapter 12 - Preferences Wordfast

Copyright © Wordfast, LLC 2016.   Page 184 of 217

Translation Preferences

The Translation Preference categories are:

• Configuring Tags

• Configuring Text Tools

• Configuring Spell Check

• Configuring Auto-Propagation

• Configuring Machine Translation

Configuring Tags

Configure the tag mode, representation, and font size by navigating to Preferences then Tags as
described below.

  Note:

The project as configured in Project Director (PD) may not support formatting tags.

To modify tag settings from the Preferences option:

 1. Click Tags under Translation Preferences.

The Tags options list appears.
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 2. The tag options are listed in the following tables, modify the options as required.

Text Formatting

Tag Option Description

Show Text Formatting Show actual formatting associated with formatting tags (when
supported). When selected, a preview appears.

Show Formatting as Tags Show the content of the formatting tags. When selected, a preview
appears, as shown in the example above.

Tag Naming

Tag Option Description

Full Name View full name of the tag. For example, Font.

Short Name View short name of the tag. For example, F.

Numbering View the tag as a number.

Automatically remove
incomplete tag pairs

Delete incomplete or incorrect tags.

Automatically apply
segment formatting

Automatically apply formatting to the entire segment.

Capitalize First Letter Capitalize the first letter of the first word in the segment.

White Space Character

Tag Description

Display spaces and NBSPs
in the editor

Show all spaces including non-breaking white spaces as a middle
dot (·).

Configuring Auto-Propagation

Auto-Propagation allows repetitive content in the file to be translated consistently, by propagating
translated segments. The Auto-Propagation options control which segments are candidates for auto
propagation.
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To edit the Auto-Propagation preferences from Preferences:

 1. Click Auto Propagation.

The Auto-Propagation preferences options list appears.

  Note:

The options listed below are only available when Auto-Propagation is enabled.

 2. Deselect Enable Auto-Propagation to disable Auto-Propagation.
 3. Select Enable Auto-Propagation across all open files to apply auto-propagation to all open files.
 4. Review the Auto-Propagation options to ensure that those required are the only ones selected. The

options are described in the following table.

Option Description

100% Matches Overwrites 100% leveraged Translation Memory (TM) matches.

Fuzzy Matches Overwrites partial Translation Memory matches.
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Option Description

Auto-propagated
Matches

Overwrites all auto-propagated matches. This means that if there are
multiple segments that have the same content, then editing one segment
auto-propagates the change in all matching segments.

Edited Segments Overwrites edited segments. This allows segments that have been edited
to be overwritten by Auto-Propagation.

Machine Translated
Segments

Overwrites machine translated content.

Committed Segments Overwrites translated content which is committed to the Translation
Memory (TM).

Configuring Text Tools

The Text Tools preferences offer the following configuration options for the text editor:

• The Auto-Suggest option populates suggestions based on source content, such as numbers,
URLs, and proper names. It can also suggest terms for the glossary, Translation Memory (TM)
matches, and Sub-segment TM matches.

• The Smart Quote option automatically changes the quotation marks to smart quotes when the
user presses the quotation mark keys on the keyboard, depending on the target language.

To configure the text editor options, navigate to Preferences and then:

 1. Click Text Tools.
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The options for the text editor appear.

 2. Select Enable Auto-Suggest checkbox, to enable Auto-Suggest.

With Auto-Suggest enabled, there are four options under Enable suggestions for:

a) Click Source to enable suggestions for sources of the segment: numbers and capitalized words
only.

b) Click Glossary to enable suggestions for terms from the glossary.

c) Click TM to enable suggestions for translations from the TM.

d) Click TM Sub-Segment to enable suggestions for parts of segments from the TM.
 3. Select Enable Smart Quotes checkbox to enable automatic conversion of standard quotes to smart

quotes (quotation marks).

Depending on the target language, the quotation marks used when the user presses the quotation
mark keys on the keyboard are changed.

Configuring Spell Check

Enabling the spell check option is a good practice to ensure high quality. Spell check is supported in
Microsoft Windows and Hunspell.

To enable or disable spell check navigate to Preferences and then:

 1. Click Spellchecker.
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The Translation Preferences for Spellchecker options appear. If this is a new project, the default,
Enable Spell Checking, is enabled.

 2. Select or deselect Enable Spell Checking.

Enabling spell checking adds the option to enable spell checking while text is being entered.
 3. If Check Spelling as you Type is enabled, select one of the following:

• Microsoft Office as the spell checking service

• Hunspell as the spell checking service
 4. Click OK to save the settings.

  Note:

If spell checking is disabled, all spelling preferences are cleared. To select spelling preferences,
select Enable Spell Checking.

Configuring Machine Translation

The automated Machine Translation (MT) feature populates translations whenever a file is open or when
there are no Translation Memory segment matches.

To enable Machine Translation and select options, navigate to Preferences and then:

 1. Click Machine Translation.
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The Machine Translation options appear.

 2. Select one of the following:

• Perform when there is no TM match, to show machine translated content when there are no
match segments.

• Always perform Machine Translation, to show machine translated content when a segment is
leveraged. TM matches appear in TM Lookup with the MT matches.

 3. Select check boxes to allow all unedited segments in active document to be leveraged with MT, and
to remove MT score from score column when segment is edited.

 4. Select Google Translate, Microsoft Translate, or WorldLingo as primary machine translator. Google
Translate, Microsoft Translate, and WorldLingo can all be enabled at one time, but only one can be
selected as primary machine translator.

 5. Select the options for each machine translator, and perform any additional tasks as required by the
machine translator.
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Translator Options

Enable Google
Translator

Enable Microsoft
Translator

Enable
WorldLingo

Languages are limited to WorldLingo Languages listed below.

 6. Read the disclaimer carefully.
 7. Click OK.

WorldLingo is limited to the language set listed below:

• Arabic

• Chinese Simplified

• Chinese Traditional

• Dutch

• English

• French

• German

• Greek

• Italian

• Japanese

• Korean

• Portuguese

• Russian

• Spanish

• Swedish

Current/New Project Preferences

If this is being accessed for a new project, the preferences are all set as defaults. For current projects,
the preferences reflect whatever has been set up for this project by the Project Manager. These
preferences cover the following topics:
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• Configuring Translation Memory

• Configuring Terminology

• Configuring Penalties

• Configuring Transcheck

• Configuring Segmentation

• Configuring Filters

Configuring Translation Memory

To configure Translation Memory settings for a project from Preferences:

 1. Click Translation Memory.

The Translation Memory options list for the current project appears.

The following steps apply to the Translation Memory section.
 2. Select Write unedited fuzzy..., to commit unedited fuzzy and exact matches to a TM.
 3. Select Copy source when..., to copy the source to the target segment when there is no match and

the TM is leveraged.
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 4. Select the Fuzzy Match Threshold percentage.

  Note:

This value specifies the TM leverage percentage limit for a fuzzy match. For example, if a value of
75% is entered, the tool marks all the translations which are leveraged below 75% match as a 'No
match' segment.

 5. Select the analysis Report Settings:

• Calculate analysis report Percentage by: Words or Segments

• Calculate Internal Fuzzy Matches in: Percentage and Include Internal Fuzzy Matches in TM
Matches

 6. Select only one condition to be followed when editing an existing Translation Unit. The options are as
follows:

• Add to TM by overwriting the existing TU (default): Overwrite the existing Translation Unit

• Add to TM; overwrite the existing TU if attributes are identical: Overwrite the existing
Translation Unit if the attributes match

• Only add to TM the new TU; do not overwrite the existing TU: No overwrite, just add new TUs
to the existing Translation Unit

• Add to TM; do not overwrite the existing TU: No overwrite, just add TUs to the existing
Translation Unit

• Do not add to TM: No addition to be made to the existing Translation Unit
 7. Select the Number of TM lookup hits.

The following steps apply to the Replaceables section.
 8. Select Enable replaceables for higher TM matches to replace the selected segments in the

translation with segments from the selected TM.

Selecting this option selects all sub-options by default. Select or deselect the terms to be replaced or
not to be replaced from the Translation Memory as listed below:

a) De-select Number replacement if not wanted

b) De-select URL replacement if not wanted

c) De-select Punctuation replacement if not wanted

d) De-select Email address if not wanted
 9. Click OK.

The Translation Memory properties for the project are set up.
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Configuring Terminology

Terminology lists (glossary) are used to leverage previously translated text, resulting in lower costs and
greater consistency.

To select Terminology options for a project from Preferences:

 1. Click Terminology in the Current Project Preferences group.

The Terminology (Glossary) preferences appear.

 2. Select Enable Fuzzy Terminology, to view fuzzy matches.
 3. Select the number of hits (matches) to be viewed.
 4. Select Enable term highlighting as you type, indicate terminology matches by highlight when

entered in the translation.
 5. Select Ignore case for term highlights, to ignore case difference in terminology matches.
 6. Click OK.

Configuring Penalties

Penalties are defined to maintain a high quality of content leveraged from Translation Memory. A relative
value is assigned to each of the penalties, which are then taken into account when calculating the
translation score. This score is used to differentiate between golden or 100 %, fuzzy, and no match.
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To define penalties for a project from Preferences:

 1. Click Penalties.

The Penalties preferences for the current project appear.

 2. Select the categories desired and supply their thresholds. The following table shows a list of penalties
with their descriptions.

Penalty Description

Case Differences in case is considered.

Non Literal Differences in special characters, including punctuation, space,
apostrophe, dash, quote, etc.

Tag Differences in tagging.

Whitespace Differences in blank spacing.

Align Differences in Translation Units with alignment attributes.
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Penalty Description

Machine Translation Differences in Translation Units based on Machine Translation.

Multiple Translation Differences in Translation Units based on duplicates within the TM with
different translations.

Local TM Differences in Translation Unit from local desktop copy.

Remote TM Differences in Translation Unit from remote TM.

Private TU Differences in work-group Translation Unit from remote TM.

Public TU Differences in non-work-group Translation Unit from remote TM.

Secondary TM Indicates more than one TM is permitted and includes the maximum as
selected.

Attribute Differences in attributes.

If Attribute is Not When custom attribute in the Translation Unit does not match the text box
attribute.

If Filename Attribute
Does Not Match

When the file name attribute in the Translation Unit does not match the
TXLF file name.

 3. Click OK.

Configuring Transcheck

Transcheck is specific to a given project and verifies certain elements in the target segments and warns
of missing or incorrect text or variables. For example, if a tag is missing or incorrect text was entered, a
warning symbol appears before the target segment. The warning is shown when you hover the mouse
over the text.

To customize the Transcheck settings from Preferences:

 1. Click Transcheck under Current Project Preferences.

The Transcheck settings appear. In the following image only the base options are shown and many
of these options present additional related options when they are selected.
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 2. Select Transcheck segments while translating to enable Transcheck for this project.
 3. To control how Transcheck checks target segments, select the different configuration settings

as described in the following table. For those options that have sub-options you will find a link to
additional information.

Setting Description

Transcheck segments
while translating

Check to enable Transcheck during translation.

Select/Deselect All Check to enable all of the following options.
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Setting Description

Blacklist Check Check if the target segment includes blacklisted terms.

Note: The blacklisted term list must be a tab-delimited file. This check is
available depending on the TMGR configuration for the project. Refer to
Configuring Blacklist Check

Capitalization Check Check differences in capitalization. To configure this option, refer to
Configuring Capitalization Check.

Edited Context Match
Check

Check if context matches from the TM were edited.

Edited Exact Match
Check

Check if exact matches from the TM were edited.

Edited Source Check Check if the source of a segment was edited.

Empty Target Check Check for empty target segments.

Forbidden Characters
Check

Check if the target segment includes forbidden characters. Refer to
Configuring Forbidden Characters Check.

Number Difference
Check

Check if the numerals in the source segment match the target segment.
Refer to Configuring Number Difference Check.

Punctuation Check Check for consistency in punctuation between source and target
segments. Refer to Configuring Punctuation Check.

Repeated Word Check Check for repeated words in the translation.

Segment Length
Check

Check if the translation complies with preset limits on characters and
words. Refer to Configuring Segment Length Check.

Extended Punctuation
Check

Check for consistency in extended punctuation between source and target
segments.

Copied Source Check Check for copied source text in the target. Refer to Configuring Copied
Source Check
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Setting Description

Spelling Check Check spelling as the translation is entered.

Note: You should still download a preview file and run spell check on the
final translation. Refer to Configuring Spell Check .

Tag Check Check for missing tags in the target segments. Refer to Configuring Tag
Check.

Terminology Check Check if the terms in the source segment are translated correctly based on
the glossary. Refer to Configuring Terminology Check.

Unconfirmed
Segment Check

Check if segment is marked unconfirmed.

Unedited Fuzzy Check Check if fuzzy matches were not edited.

Unedited MT Check Check if machine translated matches were not edited.

Untranslatable Text
Check

Check if the untranslatable content in source and target segments is
consistent. Refer to Configuring Untranslatable Text Check.

Untranslated Text
Check

Check if any segments are not translated; for example, if Copy Source was
used.

Whitespace Check Check for white space in the translation. Refer to Configuring Whitespace
Check.

 4. Click OK.

The Transcheck configuration is complete and active for the current project.

Configuring Blacklist Check

To configure the checking for blacklisted words for a given project from the Preferences option:

 1. Click Transcheck.
 2. Select Blacklist Check.
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The related options appear.

 3. Select the appropriate options.

Option Description

Skip exact matches Do not check the blacklist when there is an exact match.

Skip context matches Do not check the blacklist when there is a context match.

Configuring Capitalization Check

To configure the checking for capitalization differences for a given project from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Capitalization Check.

The related options appear.

 3. Select the appropriate options.

Option Description

All Caps Mismatch Check text in the target that is all in upper case, when the
source is not all in upper case

First Word Case Difference Check Check the first letter of the first word is capitalized consistently
in source and in target.
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Option Description

Target Capitalization Mismatch
Check

Check upper case text in the target that is in lower case in the
source.

Source Capitalization Mismatch
Check

Check upper case text in the source that is in lower case in
the target.

Skip exact matches Disable or enable checking for capitalization on exact
matches.

Skip context matches Disable or enable checking for capitalization on context
matches.

Configuring Forbidden Characters Check

To configure the checking for forbidden characters from the Preferences option:

 1. Click Transcheck.
 2. Select Forbidden Character Check.

The forbidden characters check is enabled.

 3. Click Add to add or edit a forbidden character.
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Add a character to be forbidden over the NEW character string.

 4. Click Update.

To remove a forbidden character from Forbidden Character checking, highlight the character and
click Remove.

Configuring Punctuation Check

Punctuation Check ensures consistency in punctuation between source and target segments.

To configure punctuation checking from the Preferences dialog box:

 1. Click Transcheck.
 2. Select Punctuation Check.
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A list of current punctuation characters expands.

 3. Click Add to add a new character to the default list of punctuation characters.
 4. Click Update.

To remove a punctuation character from checking, highlight the character in the list and click
Remove.

 5. Select any of the following options:

• Double Punctuation Check to check for repeated punctuation

• Skip exact matches to disable or enable checking for punctuation on exact matches

• Skip context matches to disable or enable checking for punctuation on context matches
 6. Click OK.

Configuring Number Difference Check

To configure the number difference check for this session from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Number Difference Check.



Chapter 12 - Preferences Wordfast

Copyright © Wordfast, LLC 2016.   Page 204 of 217

The related option appears.

 3. Select any of the following options:

• Treat numbers separated by hyphens and dashes as single number to accept hyphenated
numbers as one

• Skip exact matches to disable or enable checking for number differences on exact matches

• Skip context matches to disable or enable checking for number differences on context matches
 4. Click OK.

Configuring Segment Length Check

Check if the translation complies with preset limits on character and word count.

To customize the segment-length checking function from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Segment Length Check.

 3. Select those options that apply.

The options are explained in the following table.

Option Description

Strict Character Length Check (Zero means
unlimited)

Check minimum and maximum character length.

Character Expansion Check Check minimum and maximum character
expansion, as a percentage.
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Option Description

Word Expansion Check Check minimum and maximum word expansion,
as a percentage.

Attribute Character Max Length Check Check attribute text that exceeds the maximum
character length set in Project Director.

Skip exact matches Disable or enable checking for segment length
on exact matches.

Skip context matches Disable or enable checking for segment length
on context matches.

Configuring Copied Source Check

To customize the copied source checking operation from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Copied Source Check.

The related options appear as shown.

 3. Select select any options that apply from the following list:

• Skip exact matches when checking for copied source

• Skip context matches when checking for copied source

• Skip tokens when checking for copied source

Configuring Spell Check

To customize the spell checking operation from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Spelling Check.
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The related options appear as shown.

 3. Select select any options that apply from the following list:

• Skip exact matches when checking for spelling

• Skip context matches when checking for spelling

Configuring Tag Check

To customize the Tag checking operation from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Tag Check.

The related options appear as shown.

  Note:

The project may not be configured in Project Director (PD) to permit formatting tags.

 3. Select any options that apply from the following list:

• Check for non-formatting tags

• Check for Source formatting missing in target

• Check for formatting that exists in target but not in source

• Skip exact matches when checking for tags

• Skip context matches when checking for tags
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Configuring Terminology Check

To configure the Terminology checking criteria from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Terminology Check.

The options appear.

 3. Select any of the following options that apply.

• Enforce Term Case: Check based on exact case matching

• Fuzzy Term Check: Include terms that approximately match

• Skip exact matches when checking for terminology

• Skip context matches when checking for terminology

Configuring Untranslatable Text Check

To configure the handling of untranslatable text checking from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Untranslatable Text Check.
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The Untranslatable Text Check expands to a dialog box.

 3. To retain the untranslatable text in the target segment, click Add.
 4. Enter the untranslatable text to be retained.
 5. Enter a custom regular expression as necessary.
 6. To remove untranslatable text from the check, highlight the text in the list and click Remove.
 7. Select any of the following options that apply:

• Skip exact matches when checking for untranslatable text

• Skip context matches when checking for untranslatable text

Configuring Whitespace Check

To configure white-space for this session from the Preferences option:

 1. Click the Transcheck.
 2. Locate and select Whitespace Check.

The options appear.

 3. Select any of the following options that apply.
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• Skip exact matches when checking for white space

• Skip context matches when checking for white space

Configuring Segmentation

These preferences specify how files should be segmented by the TXLF editor for a given project.

 1. Open Wordfast Pro and select a project from the project list.
 2. Click Open Project.
 3. Click Preferences under Options.

The overall preferences setup panel appears.
 4. Click Segmentation in the Current Project Preferences section.
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The Segmentation options appear.

The balance of the Segmentation options are shown below.
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 5. Select the required segmentation options. These options are:

• Select Segmentation on break to enable segmentation on line breaks.

• Select APPLICATION or SRX for where to apply this from the drop-down list.
 6. Define the characters that end a segment (ESM):

• Enter specific characters into the input field to specify custom segment end characters

• Select Space to enable white-spaces as a segment end character

• Select Tab to enable tabs as a segment end character

• Select Non Breaking Space to enable non-breaking white-spaces as a segment end character

• Select Line Feed to enable line-feed ASCII codes as a segment end character

• Select Carriage Return to enable carriage return ASCII codes as a segment end character
 7. Define the rules for the markers, select those that apply:

• A number followed by an end of a segment marker.

• Segment ends in a segment marker without a trailing space character.

• Segment ends in a segment marker, followed by a space character and a lower-case letter.
 8. Select abbreviations that should not be used in segmenting, see the following dialog box segment.

Configuring Filters

There are common file filters that can be enabled for a given project by navigating to Preferences then
Filters as described below.

 1. Open Wordfast Pro and select a project from the project list.
 2. Click Open Project.
 3. Click Preferences under Options.

The overall preferences setup panel appears.



Chapter 12 - Preferences Wordfast

Copyright © Wordfast, LLC 2016.   Page 212 of 217

 4. Click Filters.

The Current (New) Project filter options appear. If filter preferences are being set for a new project
this display indicates New Project Preferences and the default filter settings are active. When filter
preferences are being reviewed or changed for an existing and currently open project the active filter
settings are shown and the display indicates Current Project Preferences.

 5. To select the file filter settings for the open project, click a filter to list the current settings in the
Format Settings box.

To add custom file filters, see Adding New File Filters.

Adding New File Filters

If the default settings of the filter of your choice is not sufficient, a new filter can be created based on one
of the supported filters.

  Note:

Only file filters that appear in the list of filters can be modified into additional file filters with a new
Symbolic Name.

To add a new file filter:

 1. Open Wordfast Pro and select a project.
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 2. Click Open Project on the Project List.
 3. Click Preferences under Options.

The overall preferences setup panel appears.
 4. Click Filters.

The Configure source file filters appears listing Available filters.

 5. Click Add.
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The New Filter dialog box appears.

 6. Select the desired filter to use as a template for a new filter.
 7. Supply the information and make appropriate selections.
 8. Click OK to save the modified filter as a new filter.

User Preferences—Advanced Settings

The User Preferences comprise the Advanced Settings as follows:

• Restore a Wordfast Pro installation to Default Preferences Settings

• Export/Import Wordfast Pro Export/Import Preferences Settings

Default Preferences Settings

This Preferences option provides the means to restore the current preferences of a Wordfast Pro
installation to factory or default settings.

To restore Wordfast Pro to factory settings, navigate to Preferences then Advanced Settings as
described below.

 1. Open Wordfast Pro.
 2. Click Preferences under Options.
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The overall preferences setup panel appears.
 3. Click Advanced Settings.

The dialog box to restore, export, or import the current settings of a Wordfast Pro installation appears.

 4. In the Default Settings section, click:

• Restore Factory to revert this Wordfast Pro installation preferences to those of a new installation.

• Restore Defaults to revert this Wordfast Pro installation preferences to default preferences.
 5. Click OK to complete the restore process.

Export/Import Preferences Settings

This Preferences option provides the means to Import and Export the current preferences of the
Wordfast Pro installation.

 1. Open Wordfast Pro.
 2. Click Preferences under Options.

The overall preferences setup panel appears.
 3. Click Advanced Settings.
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The options to restore, export, or import the current settings of a Wordfast Pro installation appears.

 4. In the Export/Import Preferences Settings section, click:

• Export to save the current preferences for a given Wordfast Pro installation
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• Import to apply saved preferences

 5. Click OK to complete the Export/Import process.
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